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Welcome 
Thank you for purchasing a LeCroy product. We're certain you'll be pleased with the detailed 
features so unique to our instruments. This Getting Started Manual includes important safety 
and installation information for your WavePro 700Zi Series oscilloscope, along with operating 
procedures to get you started viewing, capturing, and analyzing your waveforms. 

This WavePro 700Zi Getting Started Manual provides information in the following manner: 

 Getting to Know WavePro acquaints you with your WavePro 700Zi Series 
oscilloscope hardware, basic controls, and connections.  

 Viewing Waveforms includes instructions on setting up your display, zooming 
waveforms, and setting up persistence. 

 Capturing Waveforms includes information on timebase settings, sampling modes, 
and vertical settings. 

 Analyzing Waveforms includes measuring with cursors, setting up parameter 
measurements, an overview of math functions, and an introduction to WaveScan. 

 Documenting your Work provides an overview of the Lab Notebook feature. 
 Save Recall includes step-by-step procedures on saving and recalling scope settings 

and waveforms. It also provides information on saving screen images and disk utilities. 
 Printing provides instructions printing waveforms and managing files. 
 Utilities provides information on the Utilities available on the oscilloscope. 

Support 

When your WavePro 700Zi Series Oscilloscope is delivered, verify that all items on the 
packing list or invoice copy have been shipped to you. Contact your nearest LeCroy customer 
service center or national distributor if anything is missing or damaged. If there is something 
missing or damaged, and you do not contact us immediately, we cannot be responsible for 
replacement. If you have any problems with your product, please refer to the Technical 
Support contacts at the end of this Getting Started Manual. You can also refer to additional 
support materials at www.lecroy.com, or the Online Help files in your instrument. 

Thank You 

We truly hope these materials provide increased comprehension when using 
LeCroy's fine products. 
Sincerely, 

 
David C. Graef 

LeCroy Corporation 
Vice President and Chief Technology Officer 
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Safety Requirements 

This section contains information and warnings that must be observed to 
keep the instrument operating in a correct and safe condition. You are 
required to follow generally accepted safety procedures in addition to the 
safety precautions specified in this section. 
Safety Symbols 

Where the following symbols appear on the instrument‘s front or rear 
panels, or in this manual, they alert you to important safety considerations. 

 

This symbol is used where caution is required. 
Refer to the accompanying information or 
documents in order to protect against personal 
injury or damage to the instrument. 

 

This symbol warns of a potential risk of shock 
hazard. 

 

This symbol is used to denote the measurement 
ground connection. 

 

This symbol is used to denote a safety ground 
connection. 

 

This symbol is used to denote a grounded frame or 
chassis terminal. 

 

This symbol shows that the switch is a Standby 
(power) switch. When it is pressed, the 
oscilloscope‘s state toggles between operating and 
Standby mode. This switch is not a disconnect 
device. The instrument can only be placed in a 
complete Power Off state by flipping the Main 
Power Switch on the back of the oscilloscope to the 
Off ‗Zero‘ position. 

 
This symbol is used to denote Alternating Current. 
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CAUTION 

The CAUTION sign indicates a potential hazard. It 
calls attention to a procedure, practice or condition 
which, if not followed, could possibly cause damage 
to equipment. If a CAUTION is indicated, do not 
proceed until its conditions are fully understood and 
met. 

WARNING 

The WARNING sign indicates a potential hazard. It 
calls attention to a procedure, practice or condition 
which, if not followed, could possibly cause bodily 
injury or death. If a WARNING is indicated, do not 
proceed until its conditions are fully understood and 
met. 

CAT I 

Installation (Overvoltage) Category rating per EN 
61010-1 safety standard and is applicable for the 
oscilloscope front panel measuring terminals. CAT I 
rated terminals must only be connected to source 
circuits in which measures are taken to limit 
transient voltages to an appropriately low level. 
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Operating Environment 

The instrument is intended for indoor use and should be operated in a 
clean, dry environment with an ambient temperature within the range of 5 
°C to 40 °C.  

Note: Direct sunlight, radiators, and other heat sources should be taken 
into account when assessing the ambient temperature.  

 WARNING  
The oscilloscope must not be operated in explosive, dusty, or wet 
atmospheres. 

 CAUTION  
Protect the oscilloscope‘s display touch screen from excessive impacts with 
foreign objects. 

 CAUTION  
Do not exceed the maximum specified front panel terminal (CH1, CH1, 
CH2, CH3, CH4, AUX IN, AUX OUT) voltage levels. Refer to Specifications 
for more details. 
Installation (Overvoltage) Category II refers to local distribution level, which 
is applicable to equipment connected to the mains supply (AC power 
source). 
Installation (Overvoltage) Category I refers to signal level, which is 
applicable to equipment measuring terminals that are connected to source 
circuits in which measures are taken to limit transient voltages to an 
appropriately low level. 
Pollution Degree 2 refers to an operating environment where normally only 
dry non-conductive pollution occurs. Occasionally a temporary conductivity 
caused by condensation must be expected.  
Protection Class 1 refers to a grounded equipment, in which protection 
against electric shock is achieved by Basic Insulation and by means of a 
connection to the protective ground conductor in the building wiring. 
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PLEASE NOTE THE FOLLOWING: 
The design of the instrument has been verified to conform to EN 61010-1 
safety standard per the following limits: 
  Installation (Overvoltage) Categories II (Mains Supply Connector) & 

I (Measuring Terminals) 
 Pollution Degree 2 
 Protection Class I 

Cooling 

The instrument relies on forced air cooling with internal fans and ventilation 
openings. Care must be taken to avoid restricting the airflow around the 
apertures (fan holes) at the sides and rear of the oscilloscope. Ensure 
adequate ventilation by leaving the required 10 cm (4 inch) minimum gap 
around the sides and rear of the instrument. 

 CAUTION  
Do not block the ventilation holes located on both sides and rear of the 
oscilloscope. 
The instrument also has internal fan control circuitry that regulates the fan 
speed based on the ambient temperature.  This is performed automatically 
after start-up with no manual intervention required. 

 CAUTION  
Do not allow any foreign matter to enter the oscilloscope through the 
ventilation holes, etc. 
AC Power Source 

100 to 240 Vrms (+/-10%) AC at 50/60 Hz; 115 Vrms (+/-10%) AC at 400 
Hz; Automatic AC voltage selection; Installation Category: 300V CAT II  
No manual voltage selection is required because the instrument 
automatically adapts to line voltage. 
WavePro 700Zi - </= 800 watts (800 VA) depending on accessories 
installed (probes, PC port plug-ins, etc.). 

Note: The instrument automatically adapts itself to the AC line input within 
the following ranges: 
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Voltage 
Range: 

90 to 264 Vrms 90 to 132 Vrms 

Frequency 
Range: 

45 to 66 Hz 360 to 440 Hz 

Power and Ground Connections 

The instrument is provided with a grounded cord set containing a molded 
three-terminal polarized plug and a standard IEC320 (Type C13) connector 
for making line voltage and safety ground connection. The AC inlet ground 
terminal is connected directly to the frame of the instrument. For adequate 
protection against electrical shock hazard, the power cord plug must be 
inserted into a mating AC outlet containing a safety ground contact. 

 WARNING - Electrical Shock Hazard 
Any interruption of the protective conductor inside or outside of the 
oscilloscope, or disconnection of the safety ground terminal creates a 
hazardous situation. 
Intentional interruption is prohibited. 
In Standby mode the oscilloscope is still connected to the AC supply. The 
instrument can only be placed in a complete Power Off state by physically 
disconnecting the power cord from the AC supply or by flipping the Main 
Power Switch on the back of the oscilloscope to the Off ‗Zero‘ position.  
The oscilloscope should be positioned to allow easy access to the socket-
outlet. Disconnect the oscilloscope from the AC supply by unplugging the 
instrument‘s power cord from the AC outlet after the oscilloscope is placed 
in Standby state. 

 CAUTION  
The outer shells of the front panel terminals (CH1, CH2, CH3, CH4, AUX 
IN, AUX OUT) are connected to the instrument‘s chassis and therefore to 
the safety ground. 
Standby (Power) Switch and Oscilloscope Operational States 

The front Standby (Power) switch controls the operational state of the 
oscilloscope. This toggle switch is activated by momentarily pressing and 
releasing it. The color of the LED below the switch indicates the status of 
the oscilloscope as follows: 
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 On (LED Green)* – oscilloscope is fully powered and operational 
 Standby (LED Off)* – oscilloscope is powered off (except for some 

housekeeping circuits) 
 Standby (LED Blinking Green) – oscilloscope‘s computer 

subsystems (hard drive, etc.) are in Standby (reduced Power mode). 
All other oscilloscope subsystems are fully powered. 

* Factory Settings 
The oscilloscope‘s factory settings result in only two basic oscilloscope 
states: On (LED Green) or Standby (LED Off). In this case of Standby (LED 
Off), the oscilloscope is powered off with the exception of some 
housekeeping circuitry (approximately 12 watts dissipation). The 
oscilloscope can only be placed in a complete power off state by 
unplugging the instrument‘s power cord from the primary power source (AC 
outlet). It is recommended that the power cord be unplugged from the AC 
outlet if the oscilloscope is not being used for an extended period of time.  
You have the ability to change the oscilloscope's original factory settings via 
the Power Options Properties menu in Windows under Control Panel → 
Power Options. It is important to note that the Windows Power Option 
named Standby provides control of only the oscilloscope‘s computer 
subsystems (CPU, hard drive, etc.) and does not affect the other 
subsystems within the oscilloscope. In general, these other subsystems 
remain fully powered. For additional information on setting these Power 
Options, see the Windows Help menu or other related technical 
documentation. In terms of control buttons, this oscilloscope uses only a 
power button/switch and therefore references to a sleep button are not 
applicable. 
The oscilloscope can always be placed in the Standby state (LED Off) – 
Power Off (except for some housekeeping circuits) by pressing and holding 
in the Standby toggle switch for approximately 5 seconds. 
Calibration 

The recommended calibration interval is one year. Calibration should be 
performed by qualified personnel only. 
Cleaning 

Clean only the exterior of the instrument, using a damp, soft cloth. Do not 
use chemicals or abrasive elements. Under no circumstances allow 
moisture to penetrate the instrument.  
Avoid electrical shock hazard by unplugging the power cord from the AC 
outlet before cleaning. 
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 WARNING - Electrical Shock Hazard 
 No operator serviceable parts inside. 
 Do not remove covers. 
 Refer servicing to qualified personnel. 

Abnormal Conditions 

Operate the instrument only as intended by the manufacturer.  
If you suspect the oscilloscope‘s protection has been impaired, disconnect 
the power cord and secure the instrument against any unintended 
operation. 
The oscilloscope‘s protection is likely to be impaired if, for example, the 
instrument shows visible damage or has been subjected to severe transport 
stresses. 
Proper use of the instrument depends on careful reading of all instructions 
and labels. 

 WARNING  
Any use of the oscilloscope in a manner not specified by the manufacturer 
may impair the instrument‘s safety protection. The instrument and related 
accessories should not be directly connected to human subjects or used for 
patient monitoring. 
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Getting to Know WavePro 
Hardware 

Front Panel 

Numbered labels on this graphic correspond with descriptions in the table. 

 
Number and 
Description 

Number and 
Description 

Number and 
Description 

1. Power Button 
2. Channel Row 

LED Indicator 
3. Channel Inputs  
4. Auxiliary Input 

and Output 

5. Volume Control 
and Mute Button 

6. Ground 
Connector 

7. Speaker 
8. Fast Edge, 

Recovered Clock, 
and Data Outputs 

9. USB Ports 
10. Detachable Front 

Panel-Remote 
Control 

11. Release Switch 
for Front Panel-
Remote Control 
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DETACHING AND ATTACHING THE FRONT PANEL  

 
Detach the front panel from the oscilloscope by sliding the detachment lever 
to the left and pulling at the right. 

 
Attach the front panel by inserting the lower part first, sliding the 
detachment lever to the left, and then pushing the top in place. 
Front Panel as a Remote Control  

While detached, the front panel can act as a remote control. Just plug-and-
play connect it to the oscilloscope using a USB - A to USB - Mini B cable.  
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Side Panel 

The WavePro Zi side panel is located on the right side (facing the front of 
the instrument) as follows: 
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Numbered labels on this graphic correspond with descriptions in the table. 

 
Number and 
Description 

Number and 
Description 

Number and 
Description 

1. LBUS (LeCroy 
Bus) 

2. Mouse 
3. Keyboard 
4. USB Ports 

5. External 
VGA Monitor  

6. Ethernet Port 
7. Line In 

8. Speakers 
9. Microphone 
10. PCI Expansion 

Slots for DVI (for 
standard display 
hardware), LSIB, 
and other options 
(LeCroy External 
Display WPZi-
EXTDISP-15 
option). 

Note: Consult your system administrator when connecting to an internal 
LAN. 
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Back Panel 

Numbered labels on this graphic correspond with descriptions in the table. 

 
Number and 
Description 

Number and 
Description 

Number and 
Description 

1. External Clock 
Input (Grounded 
EMI Shield 
required when 
port is not in use) 

2. External Clock 
Output 

3. Removable Hard 
Drive  

4. DVD-CD + R 
Drive 

5. Power Switch 
6. DC Power Plug 
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External Monitor 

Setting up the External Monitor involves a connection and a few touch 
screen selections. It's a hot swap connection, so there's no need to restart 
the instrument once you've connected. 

1. Plug your external monitor (WPZi-EXTDISP15 option) display into 
the DVI and DC 12 connections on the PCI slot (located on the side 
of the oscilloscope). Connect your USB plug (where applicable) to an 
available port (also on the side of the instrument). 

 
Note: To connect a standard VGA monitor, connect to the VGA Port. 

2. Turn on the oscilloscope, let the instrument boot and then touch 
Display → Display Setup... from the menu bar. 

3. Touch the Monitor tab and then the Enable External Monitor 
button. 

 
4. Touch inside the Brightness field and adjust brightness as 

necessary. 
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The following picture shows a WavePro 700Zi with the LeCroy external 
monitor attached (optional WPZi-EXTDISP-15). 

 



WavePro 7Zi 

20 WP7Zi-GSM-E-RevA 

Dual Channel Acquisition 

COMBINING CHANNELS 

Channels can be combined to increase sample rate, memory, or both in 
order to capture and view a signal in all its detail. When you combine 
channels, uncombined channels like EXT BNC remain available for 
triggering, even though they are not displayed. 
In 2-channel operation, channels 2 and 3 are made active. Channels 1 or 2, 
and 3 or 4 can be used in Auto operation for 20 GS/s. When channels are 
paired in the following combinations, the maximum sampling rate is doubled 
and the record length is greatly increased: 

Channel Combinations Receiving 40 GS/s 

Channels 1 and 3 
Channels 1 and 4 
Channels 2 and 3 
Channels 2 and 4 

Note: These sample rates apply to all WavePro Zi oscilloscopes (except 
the 715Zi without the WPZi 1GHz 4x20 GS option). 

In short, sampling can be maximized to 40GS/s using two channel 
combinations except for channels 1 and 2, or channels 3 and 4 (which 
always yield 20 GS/s. Use best practice by choosing channel 1 or 2 for your 
first input, and channel 3 or 4 for the second. 
Refer to Acquisition Modes in the specifications for maximum sample rates. 
Combining Channels Procedure 

Set up channel combinations on the interface as follows: 
1. Touch Timebase → Horizontal Setup on the menu bar and the 

Horizontal Setup dialog is shown. 
2. Under Active Channels, touch 4, 2 or Auto. The maximum sample 

rate is shown alongside each button. 
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Basic Controls 

Hardware and Software Controls 

The following Basic Control topics cover the general usage of the hardware 
buttons located on the oscilloscope's front panel and the screen control 
interface elements of the software. 
Front Panel Controls 

Note: Some front panel controls correspond with screen layout controls in 
specific ways. For example, the Print front panel general control button 
corresponds with the Hardcopy function at Utilities → Utilities Setup → 
Hardcopy. 
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The detachable WavePro Zi front panel. 
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Front Panel Groupings 

The front panel is divided into sections based on functions. The following 
sections explain them in a bit more detail. 

MISCELLANEOUS SETUP CONTROLS 

 
 Help - Press to open the LeCroy Online Assistant where you can 

click to open the oscilloscope online help table of contents, index, or 
search for a topic using a keyword. If the second monitor is installed, 
the online help opens on the second monitor. 

 Default Setup - Press to reset the oscilloscope's settings to the 
default configuration. Corresponds with screen menu selection: File 
→ Recall Setup → Recall Default Setup. For a list of default 
settings, see Save/Recall → Saving and Recalling Scope 
Settings. 

 Auto Setup - Press once and the Auto Setup flyout menu opens. 
Press the Auto Setup button on the flyout menu to perform a full 
auto setup. Press a Channel Find Scale button on the flyout menu 
to perform a quick auto setup for that channel only. Press the AUTO 
SETUP front panel button twice to perform the last selection from the 
Auto Setup flyout menu (the default is to perform a full auto setup). 

 WaveStream - Indicates when the acquisition mode is set to 
WaveStream. 

 Intensity - Press to toggle between the most recently selected 
Acquisition/Sampling Mode and WaveStream mode. When you turn 
the knob, if WaveStream is ON, the WaveStream display intensity 
changes. When you turn the knob, if WaveStream is OFF, changes 
the Intensity setting. Corresponds with the screen menu selection: 
Display → Display Setup. 
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TRIGGER FRONT PANEL CONTROLS 

 
 Level - Press to toggle between 50% trigger level and the previous 

level setting. Turn to change the trigger threshold level. This level is 
indicated on the Trigger label. 

 Trigger - Indicates the trigger status as READY and TRIG'D. 
READY is lit when the trigger is armed. TRIG'D is lit momentarily 
when a trigger occurs. A fast trigger rate will cause the light to stay lit 
continuously.  

 Setup - Press once to open the Trigger Setup dialog. Corresponds 
with screen menu selection: Trigger → Trigger Setup. Press the 
Trigger SETUP front panel button again to close the Trigger Setup 
dialog.  

 Auto - Press to turn on  Auto Trigger mode, which triggers the 
oscilloscope after a time-out, even if the trigger conditions are not 
met. 

 Normal - Press to turn on Normal Trigger mode, which triggers the 
oscilloscope each time a signal is present that meets the conditions 
set for the type of trigger selected. 

 Single - Press to turn on Single Trigger mode, which arms the 
oscilloscope to trigger once (single-shot acquisition) when the input 
signal meets the trigger conditions set for the type of trigger selected. 
If the scope is already armed, it will force a trigger. 

 Stop - Press to prevent the scope from triggering on a signal. If you 
boot up the instrument with the trigger in Stop mode, the message 
"no trace available" will be displayed. Press the Trigger AUTO front 
panel button to display your trace. 
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HORIZONTAL FRONT PANEL CONTROLS 

Note: Horizontal front panel controls correspond with screen menu 
selection: Timebase → Horizontal Setup. 

 
 Delay  - Press to toggle between a zero horizontal delay value and 

the previous horizontal delay value. Turn to change the horizontal 
delay value. 

 Time  - Turn to set the time/division of the oscilloscope timebase 
(acquisition system). The time scale is adjusted from the left edge of 
the display. 
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VERTICAL FRONT PANEL CONTROLS 

Note: Vertical front panel controls correspond with screen menu selection: 
Vertical → Channel Setup. 

 
 Channels - Press a Channel 1-4 front panel button to turn the 

channel on or off. When a Channel 1-4 front panel button is lit, the 
Vertical Offset and Volts/Div knobs are "active" for that channel only.  

 Offset  - Press to toggle between a zero vertical offset value and the 
previous vertical offset value for the selected channel. Turn to 
change the vertical offset value for the selected channel.  

 Gain - Press to toggle between fixed and variable gain adjustment. 
Turn to change the gain value. 
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CURSORS FRONT PANEL CONTROLS 

Note: Cursors front panel controls correspond with screen menu 
selection: Cursors → Cursors Setup. 

 
 Absolute Cursor - Press to set the cursor position to the default 

25% position, either horizontal or vertical (depending on which cursor 
type your are using). Turn to adjust the position of the cursor 
(absolute cursor or one of the two relative cursors). 

 Cursor Type - Press one to turn cursors ON to the last cursor type 
selected. Each subsequent press toggles through the cursor types 
(Off, Abs Horizontal, Rel Horizontal, Abs Vertical, or Rel 
Vertical). 

 Relative Cursor - Press to set the relative cursor to the default 75% 
position, either horizontal or vertical (depending on which cursor type 
you are using)Turn to adjust relative cursors. It does not work with 
absolute cursor types. 
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WAVESCAN FRONT PANEL CONTROLS 

Note: WaveScan front panel controls correspond with screen menu 
selection: Analysis → WaveScan. 

 
 Scroll - If WaveScan is On, turn to scroll through the table of 

WaveScan-filtered events. If WaveScan is Off, turn to adjust the 
selected data entry field. 

 On/Off - Press to toggle between WaveScan On and Off. This is the 
same as checking Enable in the WaveScan dialog. When you turn 
WaveScan On, it turns on the WaveScan to the last enabled mode 
on the last selected Channel with the last selected Filter method. It 
also turns on the Z1 trace with its source as the WaveScan Channel 
and changes whatever display grid was selected to a dual grid with 
channels in the top grid and the WaveScan Z1 trace in the bottom 
grid. 

 Setup  - Press once to open the WaveScan dialog. Corresponds 
with screen menu selection: Analysis → WaveScan. Press the 
WaveScan SETUP front panel button again to close the WaveScan 
dialog. 
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GENERAL CONTROLS FRONT PANEL CONTROLS 

 
 Print - Press once and the Print flyout menu opens.  

Press the Print Now button on the flyout menu to print the current 
screen image using the Print settings on the Utilities → Utilities 
Setup → Hardcopy dialog.  
Press the Print Setup button on the flyout menu to open the Utilities 
→ Utilities Setup →Hardcopy.  
Press the Save Screen to file button on the flyout menu to save the 
screen image as a file to storage media such as a USB drive or hard 
drive using the File settings on the Utilities → Utilities Setup → 
Hardcopy dialog (incrementing the filename by one each time you 
touch Save Screen to File).  
Press the Save Screen to Clipboard button on the flyout menu to 
save the current screen image to the clipboard.  
Press the Send Screen to Email button to send the current screen 
image using the email settings on the Utilities → Utilities Setup → 
Hardcopy dialog.  
Press the Create Notebook Entry button on the flyout menu to 
create a new lab notebook entry using the Enter Notebook Info 
window.  
Press the PRINT front panel button twice to perform the last selection 
from the Print flyout menu (the default is to print the screen image). 

 Touch Screen  - Press to toggle the touch screen on and off. 
 Clear Sweeps - Press to clear data from multiple sweeps 

(acquisitions) including: persistence trace displays, averaged traces, 
parameter statistics, and Histicons. During waveform readout, 
cancels readout.This is the same as pressing Clear Sweeps on the 
Measure → Measure Setup or Math → Math Setup dialogs. 
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ZOOM AND MATH FRONT PANEL CONTROLS 

Note: Zoom and Math front panel controls correspond with screen menu 
selection: Math → Zoom Setup. 

 
 Horizontal Position - Press to reset the horizontal zoom position to 

zero. Turn to change the horizontal position of the selected math or 
zoom trace. 

 Horizontal Ratio - Press to toggle between fixed and variable 
horizontal zoom ratio adjustment. Turn to change the horizontal 
zoom ratio of the selected math trace. 

 Quick Zoom - Press to automatically display magnified views of up 
to four signal inputs on multiple grids. With four input signals, the 
signals are displayed along with four zoom traces, each on its own 
grid. Pressing this button also turns off all other traces. 

 Vertical Position - Press to reset the vertical zoom position to zero. 
Turn to change the vertical position of the selected math or zoom 
trace. 

 Vertical Ratio - Press to toggle between fixed and variable vertical 
zoom ratio adjustment. Turn to change the vertical zoom ratio of the 
selected math trace. 
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Screen Layout, Groupings, and Controls 

The instrument's screen is divided into three main sections: 
 Menu Bar 

 Signal Display Grid  

 Dialog(s) 

Note: Some front panel controls correspond with screen layout controls in 
specific ways. For example, the Print front panel general control button 
corresponds with the Hardcopy function at Utilities → Utilities Setup → 
Hardcopy. 

MENU BAR 

The top of the screen contains a menu bar of commonly used functions. 
Whenever you touch one of these buttons and make a selection from its 
drop-down menu, the dialog area at the bottom of the screen displays the 
corresponding dialog. 
Specific Menu Bar functions are referenced using arrow-separated path 
descriptions. For example, the Save Setup function is referenced as File → 
Save Setup.  
The Quick Access Toolbar  

The Quick Access toolbar is located on the right side of the menu bar. You 
can use these toolbar buttons to quickly access trigger functions. 

 
 Auto - Press to turn on  Auto Trigger mode, which triggers the 

oscilloscope after a time-out, even if the trigger conditions are not 
met. 

 Normal - Press to turn on Normal Trigger mode, which triggers the 
oscilloscope each time a signal is present that meets the conditions 
set for the type of trigger selected. 

 Single - Press to turn on Single Trigger mode for the selected 
channel, which arms the oscilloscope to trigger once (single-shot 
acquisition) when the input signal meets the trigger conditions set for 
the type of trigger selected. If the scope is already armed, it will force 
a trigger. 

 Stop - Press to prevent the scope from triggering on a signal. If you 
boot up the instrument with the trigger in Stop mode, the message 
"no trace available" will be displayed.  
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 Trigger Setup - Press to open the Trigger Setup dialog. 
Corresponds with screen menu selection: Trigger → Trigger Setup.   

THE SIGNAL DISPLAY GRID 

You can set up the signal display area by touching Display → Display 
Setup from the menu bar. The Display dialog offers a choice of grid 
combinations and can also set the grid intensity.  
The following Display Grid features also provide assistance when 
using the oscilloscope: 

 Descriptor Labels - For more information, go to the Trace 
Descriptors topic. 

 Pop-up Menu  - You can click on a waveform to open a pop-up 

menu .  
 
From this pop-up menu, you can perform the following functions: 

 Open the Setup dialog for the trace 
 Turn the trace descriptor label off 
 Open the Math dialog for the trace 
 Open the Measure dialog for the trace 
 Annotate the selected trace 
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DIALOG AREA 

The lower portion is where information is shown, selections are made, and 
data is input. Typically they are organized into tabular displays, subtabs, or 
pop-up dialogs. The dialog area is controlled by touch screen buttons and 
front panel buttons. 
The following Dialog Area controls also provide assistance when entering 
data: 

 Slider Bar - When you click in some data entry fields, a slider bar 
opens at the bottom of the screen.  

You can use the slider bar on the left to make fine adjustments to 
the value. You can use the value slider on the right to make 
coarse adjustments to the value. You can click on the value slider 
to set the field to a specific value. Click the Default button on the 
slider bar to set the field to the default value. Click the keypad 

button  on the slider bar to set the value using the pop-up 
numeric keypad. 

 Flyout Menu - The Print and Auto Setup front panel buttons open 
flyout menus. For more information on these menus, go to the Front 
Panel Groupings topic. 
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Connecting 

Universal ProBus/ProLink Interface 

LeCroy's ProBus probe system provides a complete measurement solution 
from probe tip to oscilloscope display. ProBus allows you to control gain 
and offset directly from your front panel. It is particularly useful for voltage, 
differential, and current active probes. It uploads gain and offset correction 
factors from the ProBus EPROM's and automatically compensates to 
achieve fully calibrated measurements.  
This intelligent interconnection between your instrument and a wide range 
of accessories offers important advantages over standard BNC and probe 
ring connections. ProBus ensures correct input coupling by auto-sensing 
the probe type, thereby eliminating the guesswork and errors that occur 
when attenuation or amplification factors are set manually. 
The LeCroy WavePro 700Zi series oscilloscopes with bandwidths of 4 to 6 
GHz include universal ProBus/ProLink probe interfaces. As shown in the 
following figure, each channel has a high bandwidth ProLink connector and 
a 50 Ω/1 MΩ ProBus connector. 

 
 Figure 1-1. A WavePro760 Zi showing the four sets of  

ProBus/ProLink probe interfaces.  
This oscilloscope is compatible with all LeCroy probes. 
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This unique interface provides the user the greatest flexibility in probe 
selection in any oscilloscope. The ProLink inputs provide a high integrity, 
high bandwidth interchangeable interface to SMA cables, LeCroy ProLink 
probes, and accessories. ProLink is used for higher bandwidth probes.  
The ProBus interface offers both 50 Ω/1 MΩ input impedance and provides 
probe power and control for a wide range of probes such as high 
impedance passive probes, high impedance active probes, current probes, 
high voltage probes, differential probes. ProBus also includes sense rings 
for detecting passive probes. All scopes with bandwidths over 4 GHz, 
except the WavePro 740Zi and760Zi, use 50 Ω inputs and provide 1 MΩ 
impedance by means of external adapters. 
The following figure shows a typical channel setup. The input selection is on 
the left hand side of the dialog box. In this case the A input, the ProLink 
interface is selected. Each input selection has its own independent settings 
for Probe attenuation, bandwidth and coupling. 

 
 Figure 1-2. The channel screen layout showing Input A's ProLink 

interface controls setup 

Note: Input A (Upper) and B (Lower) refer to the two rows of input 
channels specifically available on WavePro 740 and 760Zi. WavePro 715, 
725, and 735Zi all have only one row of input channels on the front panel, 
and one corresponding selected input on the screen layout. 
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The setup for the ProBus interface is shown in the following figure. This 
interface also allows the selection of input impedance, 50 Ω/1 MΩ. 

 
 Figure 1-3. The channel screen layout showing Input B's ProBus 

interface controls setup 

Another universal probe interface advantage is the ability to switch between 
two probe setups. This function is remotely programmable allowing the 
interface to operate like a switch. 
The characteristics of the universal ProBus/ProLink Interface are shown in 
the following table. Each of the interfaces provide power to the probe. An 
I2C interface allows communication with the probe which permits probe 
recognition and interaction. This adds to the flexibility of the system as the 
scope can sense and control each probe. 

Probe Interface 
ProBus 

(Bandwidth) 
ProLink 

(Bandwidth) 
50 Ω 3.5 GHz 4-6 GHz 
1 MΩ 500 MHz NA 

 Table 1-1.Probe interface characteristics 

The WavePro 740Zi and 760 Zi oscilloscopes offer the universal 
ProBus/ProLink probe interface which allows dual inputs in the DC to 3.5 
GHz range and a dedicated high bandwidth interface in the range of 4 
through 6 GHz. 
The ability to select four out of eight inputs provides unheard of connection 
flexibility and eliminates the need for costly, easy to lose adapters. 
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ProLink Interface 

For some instruments, LeCroy's ProLink Adapters (LPA) give you the ability 
to connect your signal in one of three ways: 

 BMA connector (only on 4 and 6 GHz models) 
 SMA using the BMA-to-SMA adapter (4 are sent standard on 4 and 6 

GHz models) 
 BNC using BMA-to-BNC adapter (optional) 

 
 Figure 1-4. BMA-to-SMA Adapter (1) and BMA-to-BNC Adapter (2) 

 
 Figure 1-5. BMA Female Connector (1), ProLink BMA-to-SMA Adapter 

(Installed, 2), and ProLink BMA-to-BNC Adapter (Installed, 3) 

Note: When connecting an active probe to the instrument, be sure to use 
a ProLink BMA-to-BNC adapter (item 3 in the figure). Do not plug the 
probe directly into the front panel connector (item 1) without an adapter. 
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CONNECTING THE ADAPTERS 

The mating end of the ProLink adapter has four fastening clips as follows: 

 
When installing an adapter on the instrument's connector panel, align the 
male 6-pin connector with the female connector and push the adapter 
straight in. There will be some resistance and you'll hear clicks as the four 
clips slide into place. Then tighten the captive screws. 
When removing an adapter, loosen the two captive screws. Push down on 
the adapter to unseat the clips. This will require some force and will be 
initially noisy, but no damage will result to the connector, the floating female 
BMA connector, or the pins, which can be 15 degrees off axis when being 
mated or unmated. 
Auxiliary Output Signals 

In addition to a calibration signal, the following signals can be output 
through the AUX OUTPUT connector: 
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Square Wave 

 
Trigger Out - can be used to trigger another scope 

 
DC level - a reference level (not available on all instruments) 

 
Trigger Enabled - can be used as a gating function to trigger 
another instrument when the scope is ready 

 

Pass/Fail - allows you to set a pulse duration from 1 ms to 500 
ms; generates a pulse when pass/fail testing is active and 
conditions are met. 

 
Aux Output Off - turns off the auxiliary output signal 

AUXILIARY OUTPUT SETUP 

1. Touch Utilities → Utilities Setup... from the menu bar. 
2. Touch the Aux Output tab. 
3. If you want a 1 kHz, 1 V square wave, touch the corresponding 

button. 
4. If you want a specialized output, touch one of the buttons under Use 

Auxiliary Output For. 
5. Touch inside the Amplitude data entry field and enter a value, using 

the pop-up numeric keypad. If you want a TTL level signal, touch the 
TTL Level checkbox. The Amplitude field will accordingly become 
unavailable. 

6. If you selected Square Wave, touch inside the Frequency data entry 
field and enter a value, using the pop-up keypad. You can set a 
value from 5.0 Hz to 5 MHz. 

7. If you selected Pass/Fail, touch inside the Pulse Duration field and 
enter a value from 1 ms to 500 ms, using the pop-up numeric 
keypad. 
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Viewing Waveforms 
Display 

Display Setup 

Note: Not all grid styles are available on all instruments. 

1. Touch Display → Display Setup on the menu bar. 
2. Touch one of the Grid combination buttons. 

  
Note: Autogrid automatically adds or deletes grids as you select more or 
fewer waveforms to display. 

3. Touch inside the grid Intensity data entry field and enter a value 
from 0 to 100 using the slider bar at the bottom of the window. 

  
Click the keypad button  on the slider bar to enter a value 
using the pop-up numeric keypad. 

4. Touch the Grid on top checkbox if you want to superimpose the grid 
over the waveform.  
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Note: Depending on the grid intensity, some of your waveform may be 
hidden from view when the grid is placed on top. To undo, simply uncheck 
Grid on top. 

3. Touch the Axis labels checkbox to permanently display the values 
of the top and bottom grid lines (calculated from volts/div) and the 
extreme left and right grid lines (calculated from the timebase). 

4. Choose a line style for your trace: solid Line  or Points . 

5. Touch inside the trace Intensity data entry field  if you 
want to change the value and enter a value from 0 to 100 using the 

slider bar at the bottom of the window. Click the keypad button  
on the slider bar to enter a value using the pop-up numeric keypad. 

Note: Access the Monitor tab for external monitor display settings. Refer 
to the External Monitor topic for more details. 

SEQUENCE MODE DISPLAY 

To set up a Sequence Mode display, you must first have selected 
Sequence trigger mode in the Timebase → Horizontal Setup dialog. You 
must also have entered a Num Segments value. For more information on 
setting up Sequence Mode, see the Sequence Sampling Mode – Working 
with Segments topic. 

1. Touch Display → Display Setup on the menu bar. 
2. Touch inside the Display Mode field and select a display mode from 

the pop-up menu. 
Moving Traces from Grid to Grid 

You can move traces from grid to grid at the touch of a button. 
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Moving a Channel or Math Trace 
1. Touch the descriptor label for the waveform that you want to move. 

 

2. Touch the Next Grid button . 

Note: If you have more than one waveform displayed on only one grid, a 
second grid will open automatically when you select Next Grid.  

XY Display 

Use XY displays to measure the phase shift between otherwise identical 
signals. You can display either voltage on both axes or frequency on both 
axes. The traces must have the same X-axis. The shape of the resulting 
pattern reveals information about phase difference and frequency ratio. 

SETTING UP XY DISPLAYS 

1. Touch Display → Display Setup on the menu bar. 
2. Choose an XY display by touching one of the XY display mode 

buttons.   
You can show the two waveforms on the XY grid only, or you can 
show the input waveforms on a single or dual grid. 

3. Touch inside the Input X and Input Y data entry fields and select 
your input sources from the pop-up windows.  

  
Note: The inputs can be any combination of channels, math functions, and 
memory locations. 
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Custom Grids 

Some instruments and software packages offer the option to display side-
by-side grids, instead of vertically stacked grids. These side-by-side grids 
are labeled Custom in the Display dialog. Included in the choices are a 3-
grid display, single, dual, and quad displays. 
Custom grids offer views of your waveform that are contracted horizontally 
and less vertically. 

Zooming Waveforms 

You can magnify a selected region of a waveform using the Zoom function. 
You can display up to four Zoom (Z1 - Z4) and eight Math Zoom traces (F1 
- F8).You can zoom: 

  a single channel (refer to  Zooming a Single Channel) 
 a math or memory trace (refer to Zooming Memory or Math 

Function Traces) 
 multiple waveforms at once (refer to  Quickly Zooming Multiple 

Waveforms) 
 segments in a sequence (refer to Sampling Modes→Sequence 

Sampling Mode – Working with Segments 
You can also use the Multi-Zoom Math function to create time-locked zoom 
traces for selected waveforms. For more information, refer to Math→Multi-
Zoom). 
At any time, you can zoom a portion of a channel waveform or Memory/ 
Math function trace by touching and dragging a rectangle around any part 
of the input waveform, see the Touch-and-Drag Zooming topic. The zoom 
trace will size itself to fit the full width of the grid. The degree of 
magnification, will depend on the size of the rectangle that you draw. 

You can also use the front panel QUICKZOOM button  to create multiple 
zooms, one for each displayed input channel. For more information, see the 
Quickly Zooming Multiple Waveforms topic. 
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PREVIEWING ZOOMED WAVEFORMS 

When you zoom a waveform, a preview of the zoomed area will appear in 
the Preview section of the Zx dialog. 

 
Zooming a Single Channel 

The Zoom button  appears as a standard button at the bottom of 
the channel Cx Vertical Adjust setup dialog for you to create a zoom trace 
of your input waveform. 

1. On the menu bar, touch Vertical→Channelx Setup.  
 
OR 

Touch the channel trace label  for a displayed channel. 

2. Touch the Zoom button  at the bottom of the Cx Vertical 
Adjust dialog. A zoom trace (one of Z1 to Z4) will be created of the 
selected channel. 

3. To vary the degree of zoom, touch the newly created Zx trace label. 
The setup dialog for the zoom (Z1 to Z4) opens. It shows the current 
horizontal and vertical zoom factors. 

4. If you want to increase or decrease your horizontal or vertical zoom 
in small increments, touch the Var. checkbox to enable variable 

zooming. Now with each touch of the zoom control buttons , the 
degree of magnification will change by a small increment. 
 
OR 
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If you want to zoom in or out in large standard increments with 
each touch of the zoom control buttons, leave the Var. checkbox 
unchecked. 
 
OR 
 
If you want to set exact horizontal or vertical zoom factors, touch 
inside the Horizontal Scale/div data entry field and enter a time-
per-div value, using the pop-up numeric keypad. Then touch 
inside the Vertical Scale/div field and enter a voltage value. 

PLEASE NOTE THE FOLLOWING: 
 To reset the zoom to x1 magnification, touch Reset Zoom in the 

dialog.  
 You can also use the Zoom and Math front panel knobs to adjust the 

horizontal and vertical zoom. 
 Horizontal Position - Press to reset the horizontal zoom 

position to zero. Turn to change the horizontal position of the 
selected math or zoom trace. 

 Horizontal Ratio - Press to toggle between fixed and variable 
horizontal zoom ratio adjustment. Turn to change the 
horizontal zoom ratio of the selected math trace. 

 Quick Zoom - Press to automatically display magnified views 
of up to four signal inputs on multiple grids. With four input 
signals, the signals are displayed along with four zoom traces, 
each on its own grid. Pressing this button also turns off all 
other traces. 

 Vertical Position - Press to reset the vertical zoom position to 
zero. Turn to change the vertical position of the selected math 
or zoom trace. 

 Vertical Ratio - Press to toggle between fixed and variable 
vertical zoom ratio adjustment. Turn to change the vertical 
zoom ratio of the selected math trace. 
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Touch-and-Drag Zooming 
1. Touch and drag a rectangle around any part of an input channel 

waveform, math trace, or memory trace. The Zoom (Z1 to Z4) dialog 
opens. 

Note: If you have enclosed a combination of channel and math or memory 
traces in the rectangle, a pop-up Rectangle Zoom Wizard will appear. 
Touch a Zoom button (Z1 to Z4) 

2. To turn off the zoom traces, touch the Undo button  at the 
top-right corner of the screen.  
 
OR 
 
Uncheck the Trace On checkbox in the dialog for each zoom trace. 

Quickly Zooming Multiple Waveforms 

Press the QUICKZOOM button  on the front panel. 
Turning Off Zoom 

1. Touch the math function trace label (or Zx trace label) for the zoom 
you want to turn off. 

2. Touch the Trace On checkbox to remove the check mark and 
disable the zoom trace. 
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Persistence 

Persistence Setup 

The Persistence feature helps you display your waveform and reveal its 
idiosyncrasies or anomalies for a repetitive signal. Use Persistence to 
accumulate on-screen points from many acquisitions to see your signal 
change over time. The instrument persistence modes show the most 
frequent signal path "three-dimensionally" in intensities of the same color, 
or graded in a spectrum of colors. 
You can show persistence for up to eight inputs for any channel, math 
function, or memory location (M1 to M4). 

SETTING UP PERSISTENCE 

1. Touch Display → Persistence Setup on the menu bar. 
2. Touch the Persistence On checkbox. 

If you want to 
set up 
persistence 
for: 

Follow these steps: 

all input 
channels at 
once 

1. Touch the All Locked button  . 

2.  Touch one of the mode buttons  . 
3. Touch the Show last trace checkbox if you want 

the last trace displayed. 
4. Touch inside the Saturation data entry field and 

enter a whole number integer, using the slider bar at 
the bottom of the window. Click the keypad button 

 on the slider bar to enter a value using the 
pop-up numeric keypad. For more information on 
saturation, see the Saturation Level topic. 

5. Touch inside the Persistence time data entry field 
and make a selection from the pop-up menu. 
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each input 
channel 
individually 

1. Touch the Per Trace button   . 
2. Touch one of the persistence mode 

buttons  next to an input channel. 
To turn off persistence for an individual channel, touch 
the left-most persistence mode button next to the 
channel. 
 
OR 
For each input channel, touch its tab to set up 
persistence for that channel. 

3.  Touch one of the mode buttons . 
4. Touch the Show last trace checkbox if you want the 

last trace displayed. 
5. Touch inside the Saturation data entry field and enter 

a whole number integer, using the slider bar at the 

bottom of the window. Click the keypad button  
on the slider bar to enter a value using the pop-up 
numeric keypad. For more information on saturation, 
see the Saturation Level topic. 

6. Touch inside the Persistence time data entry field and 
make a selection from the pop-up menu. 

7. If you want to return all input channel setups to their 
default settings, touch the Reset All button. 

  
  

WaveStream Mode 

 

This fast viewing mode provides brightness-graded intensity 
with a decay time similar to the action of phosphor on an 
analog screen.  WaveStream mode operates at up to 40 GS/s 
with an update rate up to 8000 waveforms/second for better 
capture of higher frequency abnormal events. 
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Adjusting Trace Intensity 

 

The INTENSITY knob adjusts the 
brightness of your trace, with the 
intensity value displayed in the 
bottom right-hand corner of the 
screen: 

 
Pushing the knob toggles 
between WaveStream fast-
viewing mode and real-time 
mode. 

Note: The INTENSITY knob 
controls trace intensity only for 
WaveStream traces. Turning 
the knob when the sampling 
mode is Real Time will also 
show a change at the bottom of 
the screen, but the trace 
intensity of the real-time trace 
will not change; i.e., the value 
displayed is for the 
WaveStream trace. To change 
the trace intensity of a real-time 
trace, touch inside the Intensity 

field  of the 
Display dialog and use the pop-
up keypad or turn the front 
panel ADJUST knob. 

  

display.chm::/Display_Display_Setup.htm
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Capturing Waveforms 
Timebase 

Timebase Setup and Control 

Set up the timebase by using the front panel Horizontal controls. 

SETTING UP ADDITIONAL TIMEBASE SETUP AND CONTROLS 

1. Touch Timebase → Horizontal Setup. The Timebase dialog opens. 
2. Touch inside the Time/Division data entry field and enter a value 

using the slider bar at the bottom of the window. Click the keypad 

button  on the slider bar to enter a value using the pop-up 
numeric keypad, or use the up/down arrows to adjust the value. 

3. Touch inside the Delay data entry field and type in a value, or use 
the slider bar at the bottom of the window. Click the keypad button 

 on the slider bar to enter a value using the pop-up keypad. 
Touch the Set To Zero button to set the delay to zero. 

Autosetup 

When channels are turned on, you can run Autosetup on those channels. If 
no channels are turned on, all channels are affected. When more than one 
channel is turned on, the first channel in numerical order with a signal 
applied to it is automatically set up for edge triggering. 
You can perform an autosetup of all these functions together by simply 

pressing Auto Setup   on the front panel, or by touching Auto Setup 

 in the Vertical, Timebase, or Trigger drop-down menu. 
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Sampling Modes 

Depending on your timebase, you can choose either Single-shot (Real 

Time) , Sequence , or RIS  mode sampling. 

Some instruments also offer  Roll  mode. 

SELECTING A SAMPLING MODE 

1. Touch Timebase → Horizontal Setup from the menu bar. 
2. In the Timebase dialog, touch a Sample Mode button. 

Single-shot Sampling Mode 

BASIC CAPTURE TECHNIQUE 

A single-shot acquisition is a series of digitized voltage values sampled on 
the input signal at a uniform rate. It is also a series of measured data values 
associated with a single trigger event. The acquisition is typically stopped a 
defined number of samples after this event occurs: a number determined by 
the selected trigger delay and measured by the timebase. The waveform's 
horizontal position (and waveform display in general) is determined using 
the trigger event as the definition of time zero. 
You can choose either a pre- or post-trigger delay. Pre-trigger delay is the 
time from the left-hand edge of the display grid forward to the trigger event, 
while post-trigger delay is the time back to the event. You can sample the 
waveform in a range starting well before the trigger event up to the moment 
the event occurs. This is 100% pre-trigger, and it allows you to see the 
waveform leading up to the point at which the trigger condition was met and 
the trigger occurred. (The instrument offers up to the maximum record 
length of points of pre-trigger information.) Post-trigger delay, on the other 
hand, allows you to sample the waveform starting at the equivalent of 
10,000 divisions after the event occurred. 
Because each instrument input channel has a dedicated ADC (Analog-to-
Digital Converter), the voltage on each is sampled and measured at the 
same instant. This allows very reliable time measurements between the 
channels. 
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On fast timebase settings, the maximum single-shot sampling rate is used. 
But for slower timebases, the sampling rate is decreased and the number of 
data samples maintained. 
The relationship between sample rate, memory, and time can be simply 
defined as: 
  

 
and 

  
Sequence Sampling Mode – Working with Segments 

Using Sequence Mode, you can store up to 15,000 triggered events as 
"segments" into the oscilloscope's memory. This is ideal when capturing 
many fast pulses in quick succession or when capturing few events 
separated by long time periods. The instrument can capture in fine detail 
complicated sequences of events over large time intervals, while ignoring 
the uninteresting periods between the events. You can also make time 
measurements between events on selected segments using the full 
precision of the acquisition timebase. 
Sequence mode offers a number of unique capabilities: 

 You can acquire up to four channels simultaneously. 
 You can minimize dead time between trigger events for consecutive 

segments.  
 You can view time stamps for acquisitions. 
 You can zoom segments or used them as input to math functions. 
 You can combine sequence mode with an advanced trigger to isolate 

a rare event, capture all instances over hours or days, and 
view/analyze each afterwards. 

 You can use Sequence mode in remote operation to take full 
advantage of the instrument's high data-transfer capability. 

In Sequence mode, the complete waveform consists of a number of fixed-
size segments acquired in single-shot mode (see the instrument 
specifications for the limits). The oscilloscope uses the sequence timebase 
setting to determine the capture duration of each segment: 10 x time/div. 
Along with this setting, the oscilloscope uses the desired number of 
segments, maximum segment length, and total available memory to 
determine the actual number of samples or segments, and time or points.  
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 Figure 3-1. How the instrument captures segments 
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SETTING UP SEQUENCE MODE 

When setting up Sequence Mode, you define the number of fixed-size 
segments acquired in single-shot mode (see the instrument specifications 
for the limits). The oscilloscope uses the sequence timebase setting to 
determine the capture duration of each segment. Along with this setting, the 
oscilloscope uses the number of segments, maximum segment length, and 
total available memory to determine the actual number of samples or 
segments, and time or points. 

 
 Figure 3-2. Setting up Sequence Mode (Adjacent) 
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1. Touch Timebase → Horizontal Setup on the menu bar. 

2. Under Sampling Mode, touch the Sequence mode button . 
3. Click the Sequence tab. 
4. Under Acquisition Settings, touch inside the Num Segments data 

entry field and enter the number of segments you want to display, 
using the slider bar at the bottom of the window. Click the keypad 

button  on the slider bar to enter a value using the pop-up 
numeric keypad. 

Note: The number of segments you choose to display (80 
maximum) can be less than the total number of segments in the 
waveform. For example, in the pop-up images above, the 
number of display segments is 10, but the total number of 
segments entered in the timebase dialog's Num Segments 
field is 100. 

5. Touch the Enable Timeout checkbox. 
6. Touch inside the Timeout data entry field and enter a timeout value, 

using the slider bar at the bottom of the window. Click the keypad 

button  on the slider bar to enter a value using the pop-up 
numeric keypad. 

Note: Use the sequence mode timeout to automatically interrupt the 
sequence acquisition if the timeout value is exceeded without a valid 
trigger. The timeout period accounts for instances when a Num 
Segments miscount occurs for some reason and the scope waits 
indefinitely for an unforthcoming segment. During that time, no 
oscilloscope functions are accessible. By means of a timeout value, 
however, the acquisition will be completed, the waveform displayed, 
and control of the oscilloscope returned to the user after the timeout 
has elapsed. 

5. Under  Display Settings, touch inside the Display mode field, and 
select a sequence mode display from the pop-up menu. 

6. Touch the SINGLE trigger front panel button. 

Note: Once a single acquisition has started, you can interrupt the 
acquisition at any time by pressing the SINGLE front panel button a 
second time or by pressing the STOP front panel button. In this 
case, the segments already acquired will be retained in memory. 
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ZOOMING SEGMENTS IN SEQUENCE MODE 

You can zoom individual segments easily using the QUICKZOOM front panel 
button. When you zoom, the zoom traces default to Segment 1. Channel 
descriptors indicate the total number of segments acquired. Zoom 
descriptors indicate [Seg #] and #Segments in the Zoom. You can scroll 
through the segments using ZOOM front panel position knob. 

 
 Figure 3-3. Sample Zoom of Segments in Sequence Mode 

1. Touch the front panel Quickzoom button . 
2. Turn the ZOOM front panel position knob to scroll through the 

segments. 
3. To vary the degree of zoom, touch the newly created Zx trace label. 

The setup dialog for the zoom (Z1 to Z4) opens. It shows the current 
horizontal and vertical zoom factors. 

4. If you want to increase or decrease your horizontal or vertical zoom 
in small increments, touch the Var. checkbox to enable variable 

zooming. Now with each touch of the zoom control buttons ,  
the degree of magnification will change by a small increment. 
 
OR 
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If you want to zoom in or out in large standard increments with 
each touch of the zoom control buttons, leave the Var. checkbox 
unchecked. 
 
OR 
 
If you want to set exact horizontal or vertical zoom factors, touch 
inside the Horizontal Scale/div data entry field and enter a time-
per-div value, using the pop-up numeric keypad. Then touch 
inside the Vertical Scale/div field and enter a voltage value. 

 

DISPLAYING AN INDIVIDUAL SEGMENT 

1. Touch Math → Math Setup on the menu bar. 
2. Touch a function tab (F1 to Fx - The number of available math traces 

depends on the software options loaded on the oscilloscope. Refer 
to the specifications for details). 

3. Touch inside the Operator1 field and select the Segment button 

 from the pop-up menu. 
4. In the dialog on the right, touch the Select tab. 
5. Touch inside the First Selected data entry field and use the slider 

bat at the bottom of the window to select the first segment you want 

to display. Click the keypad button  on the slider bar to enter a 
value using the pop-up numeric keypad. 

Note: In Persistence mode, the segments are automatically overlaid 
one on top of the other in the display. In non-Persistence mode, they 
appear separately on the grid. 
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VIEWING TIME STAMPS 

You can view time stamps for each segment.  

 
 Figure 3-4. View Segment Time Stamps 

1. Touch Timebase → Acquisition Status on the menu bar. 
 
OR 
 
Touch Vertical → Channel Status on the menu bar. 

2. Touch the Trigger Time tab. 
3. Under Show Status For, touch the Time button. 
4. Touch inside the Select Segment field and enter a segment number, 

using the pop-up keypad or touch the arrow buttons to scroll through 
segment times. 
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RIS Sampling Mode -- For Higher Sampling Rates 

RIS (Random Interleaved Sampling) is an acquisition technique that allows 
effective sampling rates higher than the maximum single-shot sampling 
rate. It is used on repetitive waveforms with a stable trigger. The maximum 
effective sampling rate of 50 GS/s can be achieved with RIS by making 100 
single-shot acquisitions at 500 MS/s. The bins thus acquired are positioned 
approximately 20 ps apart. The process of acquiring these bins and 
satisfying the time constraint is a random one. The relative time between 
ADC sampling instants and the event trigger provides the necessary 
variation, measured by the timebase to 5 ps resolution. 
The instrument requires multiple triggers to complete an acquisition. The 
number depends on the sample rate: the higher the sample rate, the more 
triggers are required. It then interleaves these segments (see figure) to 
provide a waveform covering a time interval that is a multiple of the 
maximum single-shot sampling rate. However, the real-time interval over 
which the instrument collects the waveform data is much longer, and 
depends on the trigger rate and the amount of interleaving required. The 
oscilloscope is capable of acquiring approximately 40,000 RIS segments 
per second. 

 

Note: RIS mode is not available when the scope is operating in Fixed 
Sample Rate mode. 
 

  

timebase.chm::/Timebase_Smart_Memory.htm
timebase.chm::/Timebase_Smart_Memory.htm
timebase.chm::/Timebase_Smart_Memory.htm


WavePro 7Zi 

60 WP7Zi-GSM-E-RevA 

Roll Mode 

If available on your instrument, Roll mode is invoked automatically when the 
time per division is 500 ms/div or greater. However, you can cancel Roll 
Mode and return to Real Time mode at any time. 
Roll mode displays, in real time, incoming points in single-shot acquisitions 
that have a sufficiently low data rate. The oscilloscope rolls the incoming 
data continuously across the screen until a trigger event is detected and the 
acquisition is complete. The parameters or math functions connected to 
each channel are updated every time the roll mode buffer is updated, as if 
new data is available. This resets statistics on every step of Roll mode that 
is valid because of new data. 

Note: If the processing time is greater than the acquire time, the data in 
memory gets overwritten. In this case, the instrument issues the warning: 
Channel data is not continuous in ROLL mode!!! and rolling will start 
over again. 
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Vertical 

Adjusting Sensitivity and Position 

ADJUSTING SENSITIVITY 

1. Press the appropriate channel push button, for example  to turn 
on channel 1.  
 
OR  
 
Touch Vertical → Channel 1 from the menu bar.  

2. Touch inside the Trace On checkbox  to display the trace. 
3. Turn the VERTICAL GAIN front panel knob for the selected channel.  

 
OR  
 
Touch inside the Volts/Div field and enter a value using slider bar. 
Click the keypad button to enter a value using the pop-up keypad, or 
use the up/down arrows. 
The voltage that you set is displayed in the trace descriptor 

label   and in the Volts/Div field. 

ADJUSTING THE WAVEFORM'S POSITION 

Turn the VERTICAL OFFSET adjust front panel knob directly above the 
channel button whose waveform you want to move vertically. Or you can 
touch inside the Offset field and type in a value on the pop-up keypad. To 
set the vertical offset to zero, touch the Zero Offset button directly below 
the Offset field. 
Coupling 

The choices of coupling are as follows: 
 DC 50 Ω (all instruments) 
 GROUND (all instruments) 
 DC 1 MΩ (some instruments) 
 AC 1 MΩ (some instruments) 
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OVERLOAD PROTECTION 

The maximum input voltage is 4 V peak. Whenever the voltage exceeds 
this limit, the coupling mode automatically switches from DC 50 Ω to 
GROUND. You will then have to manually reset the coupling to DC 50 Ω, as 
described next. 

SETTING COUPLING 

1. Touch Vertical → Channel X Setup from the menu bar. 
2. Touch inside the Coupling field and select a coupling mode from the 

pop-up menu. 
Probe Attenuation 

SETTING UP PROBE ATTENUATION 

LeCroy's ProBus system automatically senses probes and sets their 
attenuation for you. If you want to set the attenuation manually, 

1. In the menu bar, touch Vertical, then select a channel from the drop-
down menu. 

2. Touch inside the Probe Atten.data entry field . Touch a 
divide-by menu selection or touch Var (variable). If you choose Var, 
type in a value using the slider bar or the pop-up numeric keypad. 

Bandwidth Limits 

Reducing the bandwidth also reduces the signal and system noise, and 
prevents high frequency aliasing. 

SETTING BANDWIDTH LIMITS 

Set bandwidth limits as follows: 
1. In the menu bar, touch Vertical, then select a channel from the drop-

down menu. 
2. Touch inside the Bandwidth field and select a bandwidth limit value 

from the pop-up menu. The options are 
 Full (all X-Stream scopes) 
 4 GHz 
 3 GHz 
 1 GHz 
 200 MHz (all X-Stream scopes) 
 20 MHz (all X-Stream scopes) 
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Linear and (SinX)/X Interpolation 

Linear interpolation, which inserts a straight line between sample points, is 
best used to reconstruct straight-edged signals such as square waves. 
(Sinx)/x interpolation, on the other hand, is suitable for reconstructing 
curved or irregular wave shapes, especially when the sample rate is 3 to 5 
times the system bandwidth. 

INTERPOLATION SETUP 

1. Touch the button for the channel you want to set up,  for 
example. 

2. In the dialog area, touch inside the Interpolation data entry field 
under Pre-Processing. Pre-Processing is meant as before Math 
processing. 

3. Touch inside the Interpolation data entry field. A pop-up menu 
appears offering Linear or Sinx/x interpolation. 

4. Touch the button for the type of interpolation you want. 

INVERTING WAVEFORMS 

If available on your instrument, touch the Invert checkbox to invert the 
waveform for the selected channel. 
Finding Scale 

You can access the Find Scale button from the channel setup dialog. This 
feature automatically calculates peak-to-peak voltage, and chooses an 
appropriate Volts/Div scale to fully display the waveform. 

USING FIND SCALE 

1. Touch the trace label for the waveform you desire. 

2. Touch the Find Scaleicon . 
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Variable Gain 

Variable Gain lets you change the granularity with which the gain is 
incremented. For example, when Variable Gain is disabled, the gain will 
increase or decrease in preset increments of 10 or 100 mV each time you 
touch the Up/Down buttons. 
However, when Variable Gain is enabled, you can increase or decrease 
the gain in increments as small as 1 mV, depending on the scale of the 
waveform. 

ENABLING VARIABLE GAIN 

1. Touch the descriptor label for the waveform whose gain you want to 
vary. 

2. Touch the Variable Gain check box. 
Channel Deskew 

Unlike the Deskew math function, channel Deskew does no resampling, but 
instead adjusts the horizontal offset by the amount that you enter. The valid 
range is dependent on the current timebase +/- 9 divisions. 

CHANNEL DESKEW SETUP 

1. In the menu bar, touch Vertical; from the drop-down menu, select a 
channel to set up. 

2. Touch inside the Deskew data entry field and enter a value using the 
pop-up numeric keypad. 
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Group Delay Compensation 

Group delay is defined as the rate of change of the total phase shift with 
respect to angular frequency through a device or transmission medium. An 
unavoidable consequence of correcting for group delay is that preshoot and 
overshoot will be added to the signal.  

 Pulse Response - A delay compensation that minimizes preshoot. 
This selection is preferred in physics applications where there's no 
prediction of the future event. 

 
 Eye Diagram - Delay compensation with less overshoot. This 

selection improves the accuracy of serial eye diagrams. 

 
 Flatness - A delay compensation similar to eye diagram, this 

selection provides a flat frequency response. 
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Triggering 

Trigger Types 

The triggers available to you are defined as follows: 
Edge  

 
A simple trigger, Edge trigger is activated by basic waveform features or 
conditions such as positive or negative slope, and holdoff. 
Width 

Width trigger allows you to define a positive- or negative-going pulse 
width bounded by a voltage level, above or below which a trigger will occur. 
Or you can specify a pulse width and voltage range, within or outside of 
which a trigger will occur. 
Glitch 

Glitch trigger is a simpler form of Width trigger. Use Glitch trigger 
when you want to define a fixed pulse-width time or time range only. Glitch 
trigger makes no provision for voltage levels or ranges. 
Interval  

While Glitch trigger performs over the width of a pulse, Interval 
trigger performs over the width of an interval — the signal duration (the 
period) separating two consecutive edges of the same polarity: positive to 
positive or negative to negative. Use interval trigger to capture intervals that 
fall short of, or exceed, a given time limit. In addition, you can define a width 
range to capture any interval that is itself inside or outside the specified 
range - an Exclusion trigger by interval. 
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Qualify First 

In Sequence acquisition mode, triggers repeat on event B only if a 
defined pattern, state, or edge (event A) is satisfied in the first segment of 
the acquisition. Delay between sources is selectable by time or events. 
Qualify 

The Qualify trigger is an edge-qualified trigger that allows you to 
use one signal's positive or negative transition to qualify a second signal, 
which is the trigger source. For Qualify trigger, you specify the time or 
number of events after the transition when you want the trigger to occur. 
State 

The State trigger is a level-qualified trigger which requires that the 
qualifying signal remain above or below a specified voltage level for a 
trigger to occur. For Sate trigger, you specify the time or number of events 
after the signal has gone above or below the voltage level when you want 
the trigger to occur. 
Dropout 

Used primarily in single-shot applications, and usually with a pre-
trigger delay, Dropout trigger can detect lost signals. The trigger is 
generated at the end of the timeout period following the last trigger source 
transition. 
Logic 

Logic trigger enables triggering on a logical combination (pattern) of 
five inputs: CH1, CH2, CH3, CH4, EXT. You have a choice of four Boolean 
operators (AND, NAND, OR, NOR), and you can stipulate the high or low 
voltage logic level for each input independently. 
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TV 

Not available on all instruments, TV triggers provide stable triggering 
on standard or custom composite video signals. Use them on PAL, 
SECAM, or NTSC systems. 
Slew Rate 

SlewRate trigger activates a trigger when the rising or falling edge of 
a pulse crosses two threshold levels: an upper level and a lower level. The 
pulse edge must cross the thresholds faster or slower than a selected 
period of time. You can select both thresholds within a range of 2 ns to 20 
s. Slew rate trigger is not available on all instruments. 
Runt 

The Runt trigger occurs when a pulse crosses a first threshold line, 
but fails to cross a second threshold line before recrossing the first. You can 
select both voltage thresholds within a time range of 100 ps to 20 s. Other 
defining conditions for this trigger are the edge (triggers on the slope 
opposite to that selected) and runt width. 
Serial Trigger and Decode 

Serial trigger allows a serial trigger condition to be set from within 
the oscilloscope, using an easy-to-understand interface. 
Serial 

 
80-bit Serial Trigger without decode capability is available on SDA model 
scopes only. 
Window 

 
Trigger when signal or exits a window defined by adjustable thresholds. 
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Simple Triggers 

 EDGE TRIGGER ON SIMPLE SIGNALS 

The instrument uses many waveform capture techniques that trigger on 
features and conditions that you define. These triggers fall into two major 
categories: 

 Simple Triggers – activated by basic waveform features or 
conditions such as a positive or negative slope, and hold-off  

 SMART Triggers – sophisticated triggers that enable you to use 
basic or complex conditions for triggering. Use SMART Triggers for 
signals with rare features, like glitches. 

Trigger Settings 

Horizontal and Vertical adjustments are typically made for all trigger types 
using either the Delay or Level knobs on the front panel of the instrument 
or their respective fields on the Timebase setup dialog. 

 Horizontal: Turn the DELAY knob in the HORIZONTAL control group 
to adjust the trigger's horizontal position. Or, touch inside the Delay 
field in the timebase setup dialog and enter a value, using the pop-up 
keypad. 

The trigger location is shown by a marker marker  under the 
grid. 

Post-trigger delay is indicated by a left-pointing  arrow  at the 
lower-left of the grid. The time value is given in the title line of the 

TimeBase label  at the lower-right of the grid. 
 Vertical: Turn the LEVEL knob in the TRIGGER control group to adjust 

the trigger's vertical threshold. 
Turn this knob to adjust the level of the trigger source or the 
highlighted trace. Level defines the source voltage at which the 
trigger will generate an event: a change in the input signal that 
satisfies the trigger conditions. 
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Alternatively, in the Trigger dialog, you can touch inside the Level 
field and type in a value using the pop-up numeric keypad. Quickly 
set a level of zero volts by touching the Zero Level button. 
An arrow on the right side of the grid shows the threshold position. 
This arrow is only visible if the trigger source is displayed. 

Edge Trigger Setup 

Channel Setup 
1. Touch the Trigger descriptor label. 

 
2. Touch the Edge trigger button.  
3. Touch inside the trigger Source field and select an input from the 

pop-up menu.  
4. Select a coupling mode. 

5. Touch inside the Level data entry field.  Using the pop-up 
numeric keypad, enter a value in millivolts or use the up/down 

buttons  to increase or decrease the value in increments 

of 1 mV. Or, touch one of the preset value buttons.  
6. Select the holdoff by touching the Time or Events buttons. 

Use the slider bar (at the bottom of the window) to enter values via 
the keypad button  to enter a value using the pop-up keypad or 

the Default button  to use preset values. Specify the unit of 
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time,  or use the up/down buttons (mentioned in the previous 
step) to increase or decrease the time value in increments of 200 ps. 
Or, touch one of the preset value buttons (also mentioned in the 
previous step). 

7. Choose Positive, Negative, or Either from the slope choices. 

 

Note: Use the TriggerScan tab to run the Trainer (a wizard-like tool to 
configure triggers), Save, and Load trigger setups for reuse. 

Trigger Setup 

TRIGGER SETUP CONSIDERATIONS 

Trigger Modes 

1. AUTO mode causes the scope to sweep even without a trigger. An 
internal timer triggers the sweep so that the display remains, even 
when the signal does not cause a trigger. 

2. In NORMAL mode, the scope sweeps only if the input signal reaches 
the set trigger point. Otherwise it continues to display the last 
acquired waveform. 

3. In SINGLE mode, only one sweep occurs each time you press the 
button. 

4. STOP mode inhibits all sweeps until you select one of the other three 
modes. 



WavePro 7Zi 

72 WP7Zi-GSM-E-RevA 

Determining Trigger Level, Slope, Source, and Coupling 

Level defines the source voltage at which the trigger circuit generates an 
event (a change in the input signal that satisfies the trigger conditions). The 
selected trigger level is associated with the chosen trigger source. Note that 
the trigger level is specified in volts and normally remains unchanged when 
the vertical gain or offset is modified. 
The Amplitude and Range of the trigger level are limited as follows: 

 ±5 screen divisions with a channel as the trigger source 
 ±400 mV with EXT as the trigger source 
 ±4 V with EXT/10 as the trigger source 
 ±40 mV with EXT*10 as the trigger source 
 none with LINE as the trigger source (zero crossing is used) 

Note: Once specified, Trigger Level and Coupling are the only parameters 
that pass unchanged from trigger mode to trigger mode for each trigger 
source. 

Coupling refers to the type of signal coupling at the input of the trigger 
circuit. Choices of trigger coupling vary by scope model. 
With DC coupling, all of the signal's frequency components are coupled to 
the trigger circuit for high-frequency bursts. 
Slope determines the direction of the trigger voltage transition used for 
generating a particular trigger event. Choose Positive, Negative, or Either 
from the slope choices.  

  
Like coupling, the selected slope is associated with the chosen trigger 
source. 
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 Figure 3-5. Edge trigger works on the selected edge at the chosen 

level. The slope (positive or negative) is specified in the Trigger label 
permanently displayed below-right of  the grid. 

Some instruments include the choice of Window  slope, which sets a 
threshold above and below the trigger level beyond which the signal must 
pass to generate a trigger. The slope can be either positive or negative. 
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Trigger Source 

The trigger Source may be one of the following: 
 The acquisition channel signal (CH 1, CH 2, CH 3 or CH 4) 

conditioned for the overall voltage gain, coupling, and bandwidth. 
 The line voltage that powers the oscilloscope (LINE). This can be 

used to provide a stable display of signals synchronous with the 
power line. Coupling and level are not relevant for this selection. 

 The signal applied to the EXT BNC connector (EXT). This can be 
used to trigger the oscilloscope within a range of ±400 mV on EXT, 
±4 V with EXT/10 as the trigger source, or ±40 mV with EXT*10 as 
the trigger source. 

 A logic pattern. 
TriggerScan 

TriggerScan is a debugging tool that helps you quickly find rare waveform 
glitches and anomalies. With TriggerScan, you can build a list of trigger 
setups to look for rare events and automatically sequence through each 
one. TriggerScan can use any type of trigger setup available including 
edge, width, and qualify as well as Smart Triggers (such as, glitch and runt 
triggers). TriggerScan automates two key processes in triggering rare 
events: 

1. Trains the system by looking at normal acquired waveforms. During 
the training, the oscilloscope analyzes the waveforms to determine 
what waveforms normally look like. Using this information, it 
generates a list of smart trigger setups to trigger on abnormal 
situations. 

2. Loads the smart trigger setups from the Trainer and cycles through 
these. As triggers occur, they are overlaid on the screen. All 
acquisition settings are preserved and you can use all the functions 
of the oscilloscope to find the root cause of these anomalies 
including, WaveScan, Histograms, and advanced analysis. 
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TRAINING TRIGGERSCAN 

The TriggerScan Trainer inspects a currently acquired waveform and 
automatically builds a list of common trigger setups used to find rare 
events.  

PLEASE NOTE THE FOLLOWING: 
 You must acquire and display at least 3 cycles of a signal before 

running the Trainer. 
 You should run the Trainer if you want to change the trigger types or 

if you change the channel or signal. 
 

1. Touch Trigger → Trigger Setup from the menu bar. 
2. On the Trigger dialog, click the TriggerScan tab. 
3. Touch inside the Source data entry field and select a channel as the 

source for the training. 
4. Touch the Trainer button. 
5. On the TriggerScan Trainer Setup window, choose the types of 

triggers the Trainer should use to train the system and then touch the 
Start Training button. The training begins. When it is complete, a list 
of smart trigger setups is displayed in the Trigger List. 
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STARTING TRIGGERSCAN 

After you have run the Trainer, the Trigger List displays a list of smart 
trigger setups. You can add or remove trigger setups. You can also update 
the selected smart trigger setup. Once you have made any changes to the 
Trigger List, you are ready to start scanning. 

 
1. Touch Trigger → Trigger Setup from the menu bar. 
2. On the Trigger dialog, click the TriggerScan tab. 
3. If you want to add a new trigger setup, touch the Trigger tab and set 

the new trigger. Then, touch the Add New button to add the new 
trigger to the Trigger List. 

4. If you want to delete a trigger setup, highlight the setup in the Trigger 
List and touch the Delete Selected button. 
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Note: If you want to delete all trigger setups in the Trigger List, touch the 
Delete All button. 

5. If you want to replace the selected trigger setup with the current 
trigger setup, highlight the setup in the Trigger List and touch the 
Update Selectedbutton. 

6. Once you have made any changes to the Trigger List, touch Start 
Scan. The oscilloscope automatically sequences through all the 
trigger setups. 

PLEASE NOTE THE FOLLOWING: 
  You can tune the dwell time that the scope will wait before 

loading the next trigger setup using the Dwell Time data entry 
field. 

 If you have Persistence display mode enabled, all trigger 
events are recorded on the display. Refer to the Persistence 
Setup topic for instructions on enabling Persistence display 
mode. 

 If you want TriggerScan to stop when the scope triggers next, 
check the Stop On Trigger checkbox. You can use this to 
isolate specific trigger setups. 

SAVING TRIGGERSCAN SETUPS 

You should save TriggerScan setups once you have made any 
modifications to the Trigger List. The current Trigger List will not be 
preserved after exiting the application unless you save it. 

1. On the TriggerScan dialog, touch inside the Setup File Name data 
entry field and enter a file name using the pop-up keyboard. 
 
OR 
 
Touch the Browse button and select a location and file name. 

2. Touch the Save Setup button. 

Note: You can load previously saved TriggerScan setups by touching the 
Browse button, locating the file and then clicking Load Setup.  
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Analyzing Waveforms 
Measure 

Measuring with Cursors 

Cursors are important tools that aid you in measuring signal values. 
Cursors are markers — lines, cross-hairs, or arrows — that you can move 
around the grid or the waveform itself. Use cursors to make fast, accurate 
measurements and to eliminate guesswork. There are two basic types: 

 Horiz(ontal) (generally Time or Frequency) cursors are markers that 
you move horizontally along the waveform. Place them at a desired 
location along the time axis to read the signal‘s amplitude at the 
selected time. 

 Vert(ical) (Voltage) cursors are lines that you move vertically on the 
grid to measure the amplitude of a signal. 

CURSOR MEASUREMENT ICONS 

Note: Not all of these measure modes are available on all scope models. 

Each cursor locates a point on the waveform. The cursor values can be 
read in the descriptor label for the trace. Use the Position data entry fields 
at the right side of the dialog to place the cursors precisely. The Readout 
icons depict what is being measured for each measurement mode. 

Icon: Description: 

 
Displays the absolute Y position. 

 

Displays the difference in Y values. The value can be read in 
the descriptor label for the trace. 

 
Displays absolute and delta cursors together. 

 
Displays the slope between cursors. 
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If there are non–time-domain waveforms displayed, there will also be a 
menu offering choices of x-axis units: s or Hz, for example. 
Cursors Setup 

Note: Setup procedures will vary depending on the measure modes 
available in your scope model. 

QUICK DISPLAY 

At any time, you can change the display of cursor types (or turn them off) 
without invoking the Cursors Setup dialog as follows: 

1. On the menu bar, touch Cursors, then Off, Abs Horizontal, Rel 
Horizontal, Abs Vertical, or Rel Vertical. 
 
OR 
 
Press the CURSOR TYPE button on the front panel repeatedly to scroll 
through each cursor type. Turn the CURSORS knobs to adjust the 
position of the cursor. 

Note: The bottom cursor knob adjusts relative cursors. It does not work with 
absolute cursor types. 

2. The cursors displayed will assume the positions previously set up. If 
you want to change their position or measurement mode, in the 
menu bar touch Cursors, then Cursors Setup in the drop-down 
menu. 

SETTING UP ABSOLUTE CURSORS 

1. Touch Cursors → Cursors Setup on the menu bar. The Standard 
Cursors dialog opens. 

2. In the dialog area, touch the Cursors On check box to display them. 
3. Touch the Horizontal Abs or Vertical Abs mode button. 
4. Touch inside the Position 1 data entry field and type in a value for 

the cursor or use the slider bar at the bottom of the window to adjust 

the cursor position. Click the keypad button  on the slider bar 
to enter a value using the pop-up keypad. 
 
OR 
 
Use the CURSORS knobs on the front panel to place the cursor. 
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 SETTING UP RELATIVE CURSORS 

1. Touch Cursors → Cursors Setup on the menu bar. The Standard 
Cursors dialog opens. 

2. In the dialog area, touch the Cursors On check box to display them. 
3. Touch the Horizontal Rel or Vertical Rel mode button. 
4. Touch a readout parameter button: Absolute, Delta, Abs+Delta, or 

Slope. 
5. Touch inside the Position 1 and Position 2 data entry fields and 

type in a value for each cursor or use the slider bar at the bottom of 
the window to adjust the cursor positions. Click the keypad button 

 on the slider bar to enter a value using the pop-up keypad.  
 
OR 
 
Use the CURSORS knobs on the front panel to place the cursors. 

6. If you want both cursors to move in unison as you adjust the position, 
touch the Track check box to enable tracking. 

CURSORS ON MATH FUNCTIONS 

 

You can place cursors on a math function whose 
X-axis has a dimension other than time (FFT, for 
example). On the Cursors Setup dialog, an X-
Axis menu will become available from which to 
choose the units. For example, if you are placing 
cursors on a histogram, select V (histo). 
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Overview of Parameters 

Parameters are measurement tools that determine a wide range of 
waveform properties. Use them to automatically calculate many attributes of 
your waveform, like rise-time, rms voltage, and peak-to-peak voltage, for 
example. 
There are parameter modes for the amplitude and time domains, custom 
parameter groups, and parameters for pass and fail testing. You can make 
common measurements on one or more waveforms. 

TURNING ON PARAMETERS 

1. Touch Measure → Measure Setup on the menu bar. 
2. Touch the On checkbox for each parameter you want to enable.  

Note: Some instruments do not have this option and will display all 
parameters together. 

3. Touch the Show Table checkbox to display the parameters below 
the grid. 

QUICK ACCESS TO PARAMETER SETUP DIALOGS 

You can quickly gain access to a parameter setup dialog by touching the 
parameter list box below the grid.  
For example, touch within P1 below the grid 

  
 
to display the setup dialog for P1.  
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Touch the row titles  to display the top 
Measure dialog. 

Note: Some instruments have only one Measure dialog. In this case, 
touching anywhere in the parameter results area displays the Measure 

dialog.  

Parameter Setup 
1. Touch the parameter tab (Px) of an unused location or one that you 

want to change. 
2. Under Type, select a measurement type: 

  

 
Measure On Waveforms - Applies measurements directly on 
the waveform denoted in the Source1 field. 

 

Math On Parameters - Performs math (addition, subtraction, 
multiplication, division) on parameters denoted in the Source1 
and Source2 fields. This feature is available with some optional 
math packages. 

 

Advanced Web Edit - Uses LeCroy's Processing Web to set up 
the measurement. This feature, which is available with the 
XWEB option, allows you to chain practically unlimited math 
functions together to operate on your waveform measurements. 

3. Touch inside the Source1 field and select a channel, math trace, 
memory trace, or other waveform to be measured. 
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4. If you selected Measure On Waveforms, touch inside the Measure 
field and select a parameter from the pop-up menu 

.  
OR 
If you selected Math On Parameters, touch inside the Math 
Operator data entry field and select a math function from the menu  

. 
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5. In the mini-dialog to the right of the main setup dialog, touch the 
Gate tab to narrow the span of measurement. 

6. Touch the Accept tab to define parameter values to be used in the 
measurement. 

Measure Modes 

The selections for Measure Mode allow you to quickly apply parameters for 
standard vertical and standard horizontal setups, and custom setups. 

STANDARD VERTICAL PARAMETERS 

These are the default Standard Vertical Parameters: 

Vertical 

mean 

sdev 

max. 

min. 

ampl 

pkpk 

top 

base 

 

../../../Content/_c_Measure/Measure_Measure_Gate.htm
../../../Content/_c_Measure/Measure_Qualified_Parameters.htm
../../../Content/_c_Measure/Measure_List_of_Parameters.htm#IndexMeanParam
../../../Content/_c_Measure/Measure_List_of_Parameters.htm#IndexStdDevParam
../../../Content/_c_Measure/Measure_List_of_Parameters.htm#IndexMaxParam
../../../Content/_c_Measure/Measure_List_of_Parameters.htm#IndexMinParam
../../../Content/_c_Measure/Measure_List_of_Parameters.htm#IndexAmplitudeParam
../../../Content/_c_Measure/Measure_List_of_Parameters.htm#IndexPkToPkParam
../../../Content/_c_Measure/Measure_List_of_Parameters.htm#IndexTopParam
../../../Content/_c_Measure/Measure_List_of_Parameters.htm#IndexBaseParam
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STANDARD HORIZONTAL PARAMETERS 

These are the default Standard Horizontal Parameters: 

Horizontal 

freq 

period 

width 

rise 

fall 

delay 

duty 

num points 

SELECTING MEASURE MODES 

1. Touch Measure → Measure Setup on the menu bar. 
2. Under Measure Mode, select the Std Vertical or Std Horizontal 

buttons. 

Note: You can choose to customize up to 12 parameters by touching My 
Measure. 

3. Touch inside the Source data entry field and choose a source for 
which the measurements should apply. 

../../../Content/_c_Measure/Measure_List_of_Parameters.htm#IndexFrequencyParam
../../../Content/_c_Measure/Measure_List_of_Parameters.htm#IndexPeriodParam
../../../Content/_c_Measure/Measure_List_of_Parameters.htm#IndexWidthParam
../../../Content/_c_Measure/Measure_List_of_Parameters.htm#IndexRiseParam
../../../Content/_c_Measure/Measure_List_of_Parameters.htm#IndexFallTimeParam
../../../Content/_c_Measure/Measure_List_of_Parameters.htm#IndexDelayParam
../../../Content/_c_Measure/Measure_List_of_Parameters.htm#IndexDutyCycleParam
../../../Content/_c_Measure/Measure_List_of_Parameters.htm#IndexNptsParam
../../../Content/_c_Measure/Measure_Customizing_a_Parameter.htm#IndexCustomParam
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Help Markers 

Help Markers clarify parameter measurements by displaying movable 
cursors and a visual representation of what is being measured.  For the "at 
level" parameters, Help Markers make it easier to see where your waveform 
intersects the chosen level. This feature also displays the hysteresis band 
that you have set about that level. 
You also have the option, by means of an Always On checkbox, to leave 
the Help Markers displayed after you have closed the Help Markers setup 
dialog. 
You have a choice of Simple or Detailed views of the markers: 

 The Simple selection produces cursors and Measure Gate 
gate posts. The gate posts are independently placeable for 
each parameter. 

 The Detailed selection produces cursors, Measure Gate gate 
posts, a label identifying the parameter being measured, and 
a level indicator and hysteresis band for "at level" parameters 
(not part of Standard Horizontal or Standard Vertical 
parameters). 

 
 Figure 4-1. Standard Horizontal Parameter Help Markers 
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 Figure 4-2. Standard Vertical Parameter Help Markers 

Setting Up Help Markers 
1. Touch Measure → Measure Setup on the menu bar. 
2. Select a Measure Mode: Std Vertical, Std Horizontal, or My 

Measure. 

3. Touch the Show All button  to display Help 
Markers for every parameter being measured on the displayed 
waveform (C2 in the examples above). 

4. Touch a P1 to Px tab  for any parameter listed; it doesn't 
matter which. Touch inside the Help Markers field and select 
SimpleThe Simple selection produces cursors and Measure Gate 
gate posts. The gate posts are independently placeable for each 
parameter.  or DetailedThe Detailed selection produces cursors, 
Measure Gate gate posts, a label identifying the parameter being 
measured, and a level indicator and hysteresis band for "at level" 
parameters. . 

Note: The choice of Simple or Detailed is applied to all parameters at the 
same time. That is, if you choose Simple markers for one parameter, all 
parameters will be displayed in this mode. 

5. Touch the Always On checkbox if you want to continuously display 
Help Markers for this parameter. 
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Math 

Introduction to Math Traces and Functions 

With the instrument‘s math tools you can perform mathematical functions 
on a waveform displayed on any channel, or recalled from any of the four 
reference memories M1 to M4. You can also set up traces F1 to Fx[The 
number of math functions that can be performed at the same time depends 
on the software options loaded on your scope.]  to do math on parameter 
measurements P1 to Px[The number of parameters that can be measured 
at the same time depends on the software options loaded on your scope.] . 
Instruments that offer more than one math trace provide enhanced 
capabilities. For example: you could set up Trace F1 as the difference 
between Channels 1 and 2, Trace F2 as the average of F1, and Trace F3 
as the integral of F2. You could then display the integral of the averaged 
difference between Channels 1 and 2.  
Any trace and function can be chained to another trace and function. For 
example, you could make Trace F1 an average of Channel 1, Trace F2 an 
FFT of F1, and Trace F3 a zoom of F2.  
Math Made Easy 

With the instrument's math tools you can perform mathematical functions on 
a waveform displayed on any channel C1 to C4, or recalled from any of the 
four reference memories M1 to M4. To do computations in sequence, you 
can also use math functions F1 to Fx as a source input waveform. Or you 
can use Parameters P1 through Px  
For example: you could set up F1 as the difference between Channels 1 
and 2, F2 as the average of F1, and F3 as the integral of F2. You could 
then display the integral of the averaged difference between Channels 1 
and 2. Any trace and function can be chained to another trace and function. 
For example, you could make F1 an average of Channel 1, F2 an FFT of 
F1, and F3 a zoom of F2. 
Refer to the Specifications to find out which math tools are available in each 
optional package. 
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SETTING UP A MATH FUNCTION 

Math Setup 

This setup mode allows you to quickly apply frequently used math 
functions. 

1. Touch Math → Math Setup on the menu bar. 
2. If there are math functions already assigned to F1 through Fx[The 

number of math traces available depends on the software options 
loaded on your scope. See Specifications.] , touch the checkbox for 
the function you want to enable. 

3. To assign a new math function to a trace, touch the Fx button for that 

trace, for example . The math function menu appears. 
4. Touch a menu selection; your new function is automatically 

assigned, with the same setups as were in place for the last function 
in that Fx position. 

5. If you want to change other setup items, like the source waveform, 

touch the appropriate Fx tab, for example . The setup 
dialog for that Fx position appears. 

6. Touch the Single function button  if you want to perform just 
one math function on the trace, or touch the Dual function button 

 to perform math on math. 
7. Touch the Graph button, then touch inside the Graph with field to 

select a graph mode. The Graph modes are as follows: 
  

Mode: Description: 

 Histogram of the values of a parameter 

 Track of each value of a parameter 

 Trend of the values of a parameter over time 
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Both Track and Trend are tools that can be used to plot measurement data 
and observe variations with respect to time. Differences between Track and 
Trend are summarized in the table below: 

Characteristic Trend  Track  

Representation Parameter value vs. event Parameter value 
vs. time 

Behavior 
Cumulative over several 
acquisitions up to 1 million 
events 

Non-cumulative 
(resets after every 
acquisition). 
Unlimited number 
of events 

Time Correlation to 
Other Data No Yes 

Monitors an 
Evolution in the 
Frequency Domain 

No. Trend points are not 
evenly spaced in time and 
therefore cannot be used 
for an FFT. 

Yes 

Monitors the 
Evolution of a 
Measurement 
Parameter over 
Several 
Acquisitions 

Yes 
No. Track resets 
after every 
acquisition. 

Ensures No Lost 
Measurement Data 

No. Since data can be 
accumulated over many 
acquisitions, and since the 
oscilloscope takes time to 
calculate measurement 
values and to display data 
before the trigger is re-
armed, data can be missed.  

Yes. Maximum 
time period that 
can be captured is 
limited by 
acquisition 
memory and 
sampling rate.  

In general, Track will be the tool to use if you want to capture a continuous 
stream of data that is spaced closely together. Trend can be used if your 
data is spaced widely apart and longer than the ―dead-time‖ of the 
oscilloscope between acquisitions. 
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FFT 

FFT SETUP 

Setting Up an FFT 

1. Touch Math → Math Setup on the menu bar. 
2. Touch a Math function trace button: F1 through Fx[The number of 

math traces available depends on the software options loaded on 
your scope. See Specifications.] a pop-up menu appears. Select FFT 

from the menu.   

3. Touch the Single  or Dual (function of a function)  button if 
the FFT is to be of the result of another math operation. 

4. Touch inside the Source1 field and select a channel, memory, or 
math trace on which to perform the FFT. 

5. Touch inside the Operator1 field: 
Select FFT from the pop-up menu if you selected Single function. 
Select another math function if you selected Dual function. Then 
touch inside the Operator2 field and select FFT from the pop-up 
menu. 

6. In the right-hand dialog, touch the FFT tab. 
7. Choose whether to Truncate[When the FFT transform size does not 

match the record length, you can truncate the record and perform an 
FFT on the shorter record. This will increase the resolution 

bandwidth.]  or Zero-fill[Zero-fill is useful when the source data 
for the FFT comes from a math operation that shortens the record. 
This is commonly encountered in filtering operations like enhanced 
resolution. The missing data points are replaced by data values, 
whose amplitudes are interpolated to fit between the last data point 
and the first data point in the record. This guarantees that there is 
not a first-order discontinuity in the filled data. Since the data at the 
end of the record is "filled" data, it is advisable to select a weighting 
window other than rectangular to minimize the effect of the fill on the 

resulting spectrum.]  the trace display. 
8. Touch the Suppress DC checkbox if you want to make the DC bin 

go to zero. Otherwise, leave it unchecked. 
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9. Touch inside the Output type field, and make a selection from the 
pop-up menu. 

10. Touch inside the Window field, select a window type. 
11. Touch inside the Algorithm field and select either Least Prime[The 

default algorithm is a least primes algorithm that computes FFTs on 
transform sizes having lengths that can be expressed as factors of 
2N*5K. This is very compatible with the record lengths encountered in 
the oscilloscope, which are often multiples of 1, 2, 4, 5, or 10.]  or 
Power of 2[The other choice is a power of two algorithm where the 
record lengths are in the form of 2N. The power of 2 algorithm 
generally runs faster than the least primes algorithm. The price that 
is paid is a record length that is not the same as the acquired signal. 
The power-of-two FFT will truncate to the nearest power-of-two less 
than record length if truncate is chosen or fill data to nearest power-
of-two greater than the record length if zero fill is selected.]  from the 
pop-up menu. 
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Analysis 

WaveScan 

INTRODUCTION TO WAVESCAN 

WaveScan enables you to search for unusual events in a single capture, or 
to scan for an event in many acquisitions over a long period of time. You 
can select from more than 20 search modes (frequency, rise time, runt, duty 
cycle, etc.), apply a search condition (slope, level, threshold, hysteresis), 
and begin scanning in a post-acquisition environment. Since the scanning 
modes are not simply copies of the hardware triggers, but "software 
triggers," the capability is much greater. 
For instance, there is no ―frequency‖ trigger in any oscilloscope, yet 
WaveScan allows frequency to be quickly scanned for. You can accumulate 
a data set of unusual events that are separated by hours or days, enabling 
faster debugging. The events are time stamped and indexed in a table from 
which you can select them for viewing individually. 
You can also set actions to occur automatically when unusual events are 
found: stop the acquisition, emit an audible beep, output a pulse, print the 
screen, save the waveform, or create a LabNotebook™ entry. 

 

Signal Views 

WaveScan provides distinct views of your signal: 

connecting.chm::/Connecting_Auxiliary_Output_Signals.htm
printing.chm::/Printing_Printing.htm
printing.chm::/Printing_Printing.htm
printing.chm::/Printing_Printing.htm
saverecall.chm::/SaveRecall_Saving_and_Recalling_Waveforms.htm
labnotebook.chm::/Notebook_Introduction.htm
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 Source view highlights all occurrences of edges that meet your 
criteria. 

 Scan Overlay (not available in WaveSurfer Xs scopes) places all 
captured edges one on top of the other in a separate grid. You can 
apply monochromatic persistence in this view. 

 Scan Histogram (not available in WaveSurfer Xs scopes) provides a 
statistical view of edges that meet your search criteria. 

 Zoom view allows you to expand a waveform feature vertically and 

horizontally; to apply further processing ; to store  

it, or to apply a descriptive label  to the feature. 

Note: The number of grids displayed varies from one to three grids 
depending on which views are enabled. WaveScan handles this function 
automatically, and there is no option to move traces from one grid to 
another, as would be the case under normal (non-WaveScan) operation. 

Search Modes 

Search modes are used to locate anomalies during acquisition. 
 Edge - for detecting the occurrence of edges; selectable slope and 

level 
 Non-monotonic - for detecting threshold re-crosses; selectable slope, 

hysteresis, and level 
 Runt - for detecting pulses that fail to cross a threshold; selectable 

polarity and thresholds 
 Measurement - for filtering and performing parameter measurements 

Parameter Measurements 

Besides parameter measurements made during acquisition, post-
acquisition measurements can also be made. The number of parameters 
available depends on the options loaded on your instrument. 
Measurements are made only on the events defined by your filter (search 
criteria). A Filter Wizard is provided to quickly establish statistical criteria 
such as ±1, 3, or 5 sigma. 

../../../Content/_c_Analysis/Analysis_Channel_View.htm
../../../Content/_c_Analysis/Analysis_Scan_Overlay.htm
../../../Content/_c_Analysis/Analysis_Scan_Histogram.htm
../../../Content/_c_Analysis/Analysis_Zoom_View.htm
../../../Content/_c_Analysis/Analysis_Edge_Mode.htm
../../../Content/_c_Analysis/Analysis_Non-monotonic_Mode.htm
../../../Content/_c_Analysis/Analysis_Runt_Mode.htm
../../../Content/_c_Analysis/Analysis_Measurements_Mode.htm
../../../Content/_c_Analysis/Analysis_Filter_Wizard.htm
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Sampling Mode 

Whenever WaveScan is enabled, the instrument reverts to Real-time 
sampling mode. 
Pass/Fail Testing 

  COMPARING PARAMETERS 

Each Pass/Fail input (Qx) can compare a different parameter result to a 
user-defined limit (or statistical range) under a different condition.  
The conditions are represented by these comparison operators:  

 
At the touch of a button, test results can also be compared to these 
standard statistical limits: 

 
  
In Dual Parameter Compare mode, your X-Stream oscilloscope can take 
parameter results measured on two different waveforms and compare them 
to each other. If desired, set your test to be true if Any or All waveforms fit 
the criteria set by the comparison condition. Setups are conveniently shown 
in the Summary box of the Qx dialog as follows: 
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 MASK TESTS 

Mask testing can be done using an existing mask, or by using a mask 
created from your actual waveform, with vertical and horizontal tolerances 
that you define. Existing  masks can be loaded from a floppy disk or from a 
network. 
You can set your mask test to be True for waveforms All In, All Out, Any In, 
or Any Out. For example, if you select All In, the test will be False if even a 
single waveform falls outside the mask. 
Masks that you create from your waveform can be confined to just a portion 
of the trace by use of a measure gate. Refer to the Measure Gate topic for 
more information on how this feature works. 

ACTIONS 

By touching the Stop Test 

checkbox

 in the 
Actions dialog, you can set up the test to end after a predetermined 
number of sweeps that you decide. 
You can also decide the actions to occur upon your waveforms' passing or 
failing, by selecting one or all of the following: 

 stop 
 audible alarm 
 print image of display 
 emit pulse (if available) 
 save waveform 

The selection Pulse  causes a pulse to be output through the Aux 
Out connector at the front of the oscilloscope. This pulse can be used to 
trigger another oscilloscope. You can set the amplitude and width of the 
pulse as described in Auxiliary Output Signals. 

measure.chm::/Measure_Measure_Gate.htm
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Depending on your scope model, you can configure up to 8 pass/fail 
conditions. The boolean conditions to determine if your waveform passes 
are as follows: 

All True All False 

Any True Any False 

All Q1 to Q4 Or All Q5 to Q8 Any Q1 to Q4 And Any Q5 to Q8 

PASS/FAIL TESTING SETUP 

Initial Setup 
1. Touch Analysis →  Pass/Fail Setup... from the menu bar. 
2. Touch the Actions tab. 
3. Touch the Enable Actions checkbox. This causes selected actions 

to occur on your waveform's passing or failing a test. 
4. Touch the Summary View checkbox to enable a line of text 

 
showing a concise status of the last waveform and keeping a running 
count of how many sweeps have passed. 

5. Touch inside the Pass If field, and select a boolean condition from 
the choices shown. 

6. If you want to set up the test to end after a finite number of sweeps, 
touch the Stop Test checkbox. Then touch inside the After data 
entry field and enter a value, using the pop-up numeric keypad. 

7. Use either the Pass  or Fail  button on the If section of 
the dialog to set actions taking place when your waveform passes or 
fails the test. 

8. The Then section of the dialog provides stop test, sound alarm, 
print result, emit pulse, or save (the waveform) actions. If you want 
to have the results printed and your scope is not equipped with a 
printer, be sure that the it is connected to a local or network printer. 
Refer to the Printing topics for more information. 

9. If you want to save your waveform automatically, touch the Save 
Setup checkbox. This will take you out of the current dialog and will 
open the Save Waveform dialog. Refer to the Save Recall 
→Saving and Recalling Waveforms topic for more information. 

10. Test Pass/Fail conditions by touching the Force Actions Once 
button. Press the Clear All button to quickly uncheck all checkboxes 
and make new selections. 

printing.chm::/Printing_Printing.htm
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Comparing a Single Parameter 
1. Touch Analysis → Pass/Fail Setup... from the menu bar. 
2. Touch one of the  Qx tabs and a setup dialog for the position is 

shown. 
3. Touch inside the Source1 field and select a source from the pop-up 

menu. 
4. Touch inside the Condition field in the main dialog and select 

ParamCompare . 
5. Touch inside the Compare Values field and select All or Any from 

the pop-up menu . By selecting All, the test will be true only if 
every waveform falls within the limit that you will set. By selecting 
Any, the test will be true if just one waveform falls within the limit. 

6. Touch inside the Condition field on the ParamCompare part of the 
dialog and select a math operator from the pop-up menu. 

 
7. Touch inside the Limit field and enter a value using the pop-up 

numeric keypad. The value entered acquires the dimensions 
corresponding to the parameters being tested. For example, if you 
are testing a time parameter, the unit is seconds. 
 

If you chose either WithinDeltaPct  or WithinDeltaAbs 
from the Condition menu, you also have the choice of setting the 
limit by means of the statistical buttons at the bottom of the 
ParamCompare dialog: 
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Comparing Dual Parameters 
1. Touch Analysis → Pass/Fail Setup... from the menu bar. 
2. Touch one of the  Qx tabs and a setup dialog for the position is 

shown. 
3. Touch inside the Condition field in the main dialog and select 

DualParamCompare . 
4. Touch inside the Source1 and Source2 fields and select a source 

from the pop-up menu. 
5. Touch inside the ParamCompare mini-dialog field and select a 

source from the pop-up menu. 
6. Touch inside the Compare Values field and select All or Any from 

the pop-up menu . By selecting All, the test will be true only if 
every waveform falls within the limit that you will set. By selecting 
Any, the test will be true if just one waveform falls within the limit. 

7. Touch inside the Condition field in the ParamCompare mini-dialog 
and select a math operator from the pop-up menu. 

 
8. Touch inside the Limit field and enter a value, using the pop-up 

numeric keypad. This value takes the dimension of the parameter 
that you are testing. For example, if you are testing a time 
parameter, the unit is seconds. 

9. If you chose either WithinDeltaPct  or WithinDeltaAbs 
from the Condition menu, touch inside the Delta field and enter a 
value.  
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Mask Testing 
1. Touch Analysis →  Pass/Fail Setup... from the menu bar. 
2. Touch one of the  Qx tabs and a setup dialog for the position is 

shown. 
3. Touch inside the Source1 field and select a source from the pop-up 

menu. 
4. Touch inside the Condition field in the main dialog and select Mask 

Test.  
5. From the Test portion of the dialog, make a selection in the Test is 

True when group of buttons .  This selection means, 
for example, that if you select All In the test is False when a single 
waveform falls outside the mask. 

6. From the Show Markers section of the dialog, choose whether or 
not to have mask violations displayed. 

7. If you are loading a pre-existing mask, touch the Load Mask tab, 
and then the File button. You can then enter the file name or browse 
to its location. 

8. If you want to make a mask from your waveform, touch the Make 
Mask tab.  

9. Touch inside the Ver Delta and Hor Delta fields and enter boundary 
values, using the pop-up numeric keypad. 

10. Touch the Browse button to create a file name and location for the 
mask if you want to save it. 

11. Touch the Gate tab, then enter values in the Start and Stop fields to 
constrain the mask to a portion of the waveform. Or, you can simply 
touch and drag the Gate posts, which initially are placed at the 
extreme left and right ends of the grid. 
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Documenting your Work 
Labnotebook 

Introduction to LabNotebook 

LeCroy's LabNotebook feature extends the documentation capabilities of 
your scope. It allows you to create an annotated notebook entry containing 
all displayed waveforms, the setup of the DSO, and user-supplied 
annotation. The notebook entry can then be converted to hardcopy format -- 
pdf, rtf, or html -- and printed or e-mailed. You can also use the default 
report layout or configure your own, and even substitute your own company 
logo in the header. 
Notebook entries are stored in an internal database and are available for 
recall at any time. Besides storing the waveform data, LabNotebook also 
stores your panel setups and parameter measurements. You have the 
capability to back up the database to external media. 
The Flashback feature allows you to recall the state of the DSO at a later 
date, including the saved waveforms and the DSO setup, so that you can 
make additional measurements. A keyword filter makes it easy to find the 
correct notebook entry to recall. 
You can choose which notebook to use for your entries, and label the 
notebook by project or user. If the scope is shared among several users, for 
example, or used for different projects, the data can be kept separately. 
Similarly, hardcopy reports can be stored in different folders. 

Note: If your external monitor is connected, the LabNotebook 
automatically opens on the external monitor. 
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Creating a Notebook Entry 
1. Touch File → Create Notebook Entry on the menu bar 

.  
A dialog box is displayed in which to enter a title and comments for 
the entry. By default, the entry is titled with the current date and time. 

  
2. Touch inside the Title field and enter a title, using the pop-up 

keyboard. Then touch inside the Description field and enter a 
description, if desired, and touch Close. 

3. The notebook entry will display your waveforms in "print colors," that 
is, on a white background to save printer ink, if you selected that 
option in notebook Preferences. Otherwise, the waveforms will 
appear on a black background.  
 
 

../../../Content/_c_LabNotebook/Notebook_Preferences.htm
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A drawing toolbar appears at top: 
Icon:  Description: 

 

The pen tool enables you to write or draw in 
freehand. You can use a mouse, or a stylus to do 
this using the touch screen. Once you click off, you 
can drag your note anywhere on your waveform. 

 

The circle tool enables you to create a circle around 
a waveform feature that you want to point out. Once 
you click off, the circle is drawn and you can drag it 
anywhere on the screen. 

 

The arrow tool enables you to draw lines with 
arrowheads for callouts.  You can rotate these lines 
through 360 degrees and drag them to any location 
on the screen. 

 

The text tool enables you to enter text callouts on 
your report. When you touch this tool, a dialog box 
opens in which to enter text by means of a pop-up 
keyboard. After you touch Close, your text will 
appear on the display as a draggable object. 

  

 

  

These are the three default colors that you can select 
for shapes, lines, and text. To use additional colors, 
touch More. 

 

When you touch More, a Custom box opens with the 
default color yellow displayed. Touch the yellow 
button to open the full color 
palette
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Icon:  Description: 

.  
When you have chosen a custom color, touch Add 
to Custom Colors; the color will appear in the 
Custom Colors palette. Then touch the color to 
enable it, and touch OK. The next object that you 
create will be in that color. 

 

If you want to erase a drawing object, touch it to 
select it, then touch Erase Selected. 

 
Touch Erase All to erase all drawn objects and text. 

 
Touch Undo to discard the last object drawn. 

 

The Move Toolbar button enables you to place the 
toolbar anywhere on the screen. Touch the button a 
second time to return it to its original fixed location. 

 

Touch Done when you are finished annotating the 
notebook entry. The name of the entry will appear in 
the list  in the LabNotebook dialog. You can now 
create a hardcopy report of it, and email or print it. 
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Save Recall 
Saving and Recalling Scope Settings 

You can quickly save and recall up to six scope panel settings internally. 
These internally saved settings are easy to recall later. You can also save 
and recall your scope panel settings as a file (.lss) on the hard disk, a 
network location, USB drive, or another location.  
Saving Scope Settings 

1. Touch File →Save Setup on the menu bar.  
2. To save the scope settings internally, under Save to Internal Setup, 

touch inside a SetupX data entry field and use the pop-up keyboard 

to enter a file name.  Touch the Save button  next to 
the SetupX data entry field. The file is saved in D:\Internal Setups, 
and the current date/time is displayed above the field.  
 
OR 
 
To save the scope settings to a file, under Save To File, touch inside 
the Save panel to file data entry field and use the pop-up keyboard 
to enter the path for the destination folder. Or touch Browse to 
navigate to the destination folder. Then, touch the Save Now button. 

 
Recalling Scope Settings 

1. Touch File → Recall Setup on the menu bar. 
2. To recall internally saved scope settings, under Recall from Internal 

Setup, touch the Recall button  next to the file you want to recall.  
 
OR 
 
To recall scope settings from a saved file, under Recall From File, 
touch inside the Recall panel from file data entry field and use the 
pop-up keyboard to enter the path to the source folder. Or touch 
Browse to navigate to the source folder. Then touch the Recall Now 
button.  
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Recalling Default Settings 

Some of the default settings for your WavePro 700Zi oscilloscope include 
the following configurations:  

 Channels 1 and 2 are turned on at 50 mV/div, 0V offset, linear 
interpolation 

 All other measurements are cleared for Math, Reference Waveforms, 
and Channels 

 Trigger is set to Channel 1 with an Auto positive edge, DC coupled, 
and with a 0V level 

 The Timebase set to 50 ns/div, 10ks, 20 GS/s, and with zero delay 
 Smart memory is set to Set max memory with 100ks selected 
 The Cursors are turned off 
 The Grids are set to AutoGrid 

If you want to reset the settings to the default configuration, press the 
DEFAULT SETUP front panel button. 
 
OR 
 
Touch File → Recall Setup on the menu bar. Touch the  Recall Default 
button  under Recall Default Setup.  
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Saving and Recalling Waveforms 

Saving Waveforms 
1. Touch File → Save Waveform on the menu bar. 
2. In the Save Waveform dialog, touch the Save To Memory button  

 or File button . 
3. Touch inside the Source field and select a source from the Select 

Source pop-up window. The source can be any trace; for example, a 
channel (C1–C4), math function (F1–F4), or a waveform stored in 
non-volatile RAM (M1–M4). 

4. Touch inside the Trace Title data entry field if you want to change 
the default name of your waveforms. Use the pop-up keyboard to 
type the new name. 

Note: You can change the name but not the sequence number. 

 CAUTION 

If you use a name that ends in a number instead of a letter, the 
instrument may truncate the number. This is because, by design, the 
first waveform is automatically numbered 0, the second 1, etc. For 
example, if you want to use waveform name "XYZ32" but it is not 
preceded by waveforms XYZ0 through XYZ31, the waveform will be 
renumbered with the next available number in the sequence.  

If you need to use a number in your waveform's name, it is 
recommended that you append an alpha character at the end of the 
number : "XYZ32a" for example. 

  
5. If you are saving to file, touch the Data Format field and select a 

format type from the pop-up menu. 
 
Depending on your selection, you may need to touch the SubFormat 
field and select a subformat. If you select ASCII, touch the Delimiter 
field and select a delimiter character from the pop-up menu: comma, 
space, semicolon, or tab. 
 

Note: The WaveML format, which enables XML output, is used for 
persistence traces. 
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6. Touch the Browse button next to the Save file in directory field and 
browse to the location where you want the file saved. The file name 
is assigned automatically and is shown below the field. 

7. Touch the Save Now button . 
Auto Save 

You can use the Auto Save feature to automatically save a waveform to 
disk after each new trigger. You can enable Auto Save from Save 
Waveform dialog by touching one of the Auto Save buttons 

 
Select Wrap (old files overwritten) or Fill (no files overwritten). 

 CAUTION 

If you select Fill, you can quickly use up all disk space on your hard 
disk. 

  

Recalling Waveforms 

Only .trc files that were saved in binary format can be recalled into the 
oscilloscope.  

1. Touch File → Recall Waveform on the menu bar. 
2. To recall a waveform from memory, in the Recall Waveform dialog, 

touch the Recall From Memory button  . Touch inside the 
Source field and select a memory location in which to store the file: 
M1 to M4. 
 
OR 
To recall a waveform from a file, in the Recall Waveform dialog, 

touch the Recall From File button  . Touch inside the 
Destination field and select a memory location in which to store the 
file: M1 to M4. Touch inside the Show only files field and select an 
area to limit the search to: channels, math functions, or memory. 
Touch inside the Recall files from directory data entry field and 
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enter the path using the pop-up keyboard. Or, touch the Browse 
button to navigate to the file. Touch inside the Next file will be 
recalled from data entry field and enter the path using the pop-up 
keyboard. Or, touch the Browse button to navigate to the file. 

3. Touch the Recall Now button.  
  

  

Disk Utilities 

Use the Disk Utilities dialog to delete files or create folders. 

Note: All of the Disk Utilities can also be accomplished using the standard 
file management tools in Microsoft Windows®. 

Deleting a Single File 
1. Touch File → Disk Utilities on the menu bar. 

2. Touch the Delete button  in the Disk Utilities dialog. 
3. Touch inside the Current folder data entry field and use the pop-up 

keyboard to enter the path to the folder that contains the file you 
want to delete. 
 
OR  
 
Touch the Browse button and navigate to the folder. 

4. Touch inside the File to be deleted data entry field and use the pop-
up keyboard to enter the name of the file. 
 
OR  
 
Touch the Browse button and navigate to the file. 

5. Once you have located the file, touch the Delete File button. 
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Deleting All Files in a Folder 
1. Touch File → Disk Utilities on the menu bar. 

2. Touch the Delete button  in the Disk Utilities dialog. 
3. Touch inside the Current folder data entry field and use the pop-up 

keyboard to enter the path to the folder that contains the file you 
want to delete. 
 
OR  
 
Touch the Browse button and navigate to the folder. 

4. Once you have located the folder, touch the Empty Folder button. 
Creating a Folder 

1. Touch File → Disk Utilities on the menu bar. 

2. Touch the Create button  in the Disk Utilities dialog. 
3. Touch inside the Current folder data entry field and use the pop-up 

keyboard to enter the path to the directory where you want to create 
the folder, and then name of the folder. 

4. Touch the Create Folder button. 
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Printing 
Print, Plot, or Copy 

The instrument gives you the ability to output files to a printer or plotter, to 
print to file, or to e-mail your files. Any Microsoft Windows® supported 
printer is supported by your instrument. 

Printing 

Setting Up the Printer 
1. Touch File → Print Setup on the menu bar. The Utilities Hardcopy 

dialog opens. 
 
OR 
 
Press the PRINT front panel button. Then, touch the Print Setup 
button on the Print flyout menu. 

2. On the Hardcopy dialog, touch the Printer icon . 
3. Under Colors, touch the Use Print Colors checkbox if you want the 

traces printed on a white background.  

Note: A white background saves printer toner. (You can change the printer 
colors in the Utilities → Preference Setup → Color dialog.) 

4. Touch inside the Select Printer field. Choose a printer from the pop-
up menu.  

5. Touch the Properties button to see your printer setup. 
4. Touch the icon for the layout Orientation you want: portrait or 

landscape. 
5. Touch the  Hardcopy Area field to choose which part of the screen 

you want to print from the pop-up menu.  Choose Grid 
Area Only if you do not need to print the dialog area and you only 
want to show the waveforms and grids. Choose DSO window if you 
want to print the dialogs with the waveforms and grids. Choose Full 
Screen if you want to print the entire screen. 
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Printing a Screen Image 

You can print in one of three ways: 

 Press the PRINT button on the front panel. Then, touch the Print 
Now button on the Print flyout menu. 

 Touch File → Print on the menu bar. 

 Touch the Print Now button  in the Utilities → Hardcopy 
dialog 

Note: The instrument uses the Print settings on the Utilities → Hardcopy 
dialog to print the screen image. 

Adding Printers and Drivers 

Note: If you want to add a printer driver, the driver must first be loaded on 
the scope. 

1. Touch File → Print Setup on the menu bar. 
 
OR 
 
Press the PRINT front panel button. Then, touch the Print Setup 
button on the Print flyout menu.  

2. On the Utilities Hardcopy dialog, touch the Printer icon . 
3. Touch the Add Printer button. A Microsoft Windows® Printer 

window opens where you can add a printer. 

Managing Files 

Use the instrument's Utilities menu to save the screen image as a file to 
storage media, such as a USB drive or hard drive. You can give your files 
custom names and create directories for them. 
Hard Disk Partitions 

The instrument's hard disk is partitioned into drive C: and drive D:. Drive C: 
contains the Windows operating system and the instrument application 
software. Drive D: is intended for data files. 
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Utilities 
Status 

From Status tab on the Utilities dialog, you can view system status. The 
System Status read-only dialog displays system information including 
model number, serial number, firmware version, and installed software and 
hardware options. 
Accessing the System Status Dialog 

1. Touch Utilities → Utilities Setup on the menu bar. 
2. Touch System Status on the Utilities dialog. 

 
OR 
 
Touch the Status tab. 

Remote communication 

From the Remote tab on the Utilities dialog, you can set up remote 
communication. You can select a network communication protocol, 
establish network connections, and configure the Remote Control Assistant 
log from the Remote dialog. The choice of communication protocols is 
limited to TCPIP and GPIB. 

PLEASE NOTE THE FOLLOWING: 
 GPIB is an option and requires a GPIB card to be installed in a card 

slot at the rear of the scope. 
 The instrument uses Dynamic Host Configuration Protocol (DHCP) 

as its addressing protocol. Therefore, it is not necessary to set up an 
IP address if your network supports DHCP. If it does not, you can 
assign a static address in the standard Windows 2000 network setup 
menu. 

The Remote Control Assistant monitors communication between your PC 
and oscilloscope when you are operating the instrument remotely. You can 
log all events, or errors only. This log can be invaluable when you are 
creating and debugging remote control applications. 
Setting Up Remote Communication. 

If you are connecting the scope to a network, first contact your Information 
Systems administrator. If you are connecting the scope directly to your PC, 
connect a GPIB or Ethernet cable between them. 

1. Touch Utilities →Utilities Setup on the menu bar. 
2. Touch the Remote tab. 
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3. Make a Port selection:TCPIP (transmission control protocol/Internet 
protocol) or GPIB (general purpose interface bus). If you do not have 
a GPIB card installed, the GPIB selection will not be accessible. 

4. If you are using GPIB, set a GPIB address by touching inside the 
GPIB Address data entry field and enter an address. 
 
OR 
If you are using TCPIP, press the Net Connections button; the 
Windows  Network Connections window opens.You can 
reconfigure the oscilloscope's connection if it is already connected to 
the network or make a new connection. 

Note: Your instrument allows you to restrict remote control access to 
certain clients. To restrict access, under Security, touch the Yes button and 
enter the IP addresses or domain name server names you want to restrict 
separated by a comma. 

Configuring the Remote Control Assistant Event Log 
1. Touch Utilities →Utilities Setup on the menu bar. 
2. Touch the Remote tab. 
3. Under Remote Control Assistant, touch inside the Log Mode data 

entry field. Select Off, Errors Only, or Full Dialog from the pop-up 
menu. 

4. To export the contents of the event log to an ASCII text file, touch the 
Show Remote Control Log button. The Event Logs pop-up window 
opens. Touch inside the DestFilename data entry field and enter a 
file name, using the pop-up keyboard. Then, touch the Export to 
Text File button. 
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Hardcopy 

From the Hardcopy tab on the Utilities dialog, you can print screen 
images. On the Hardcopy dialog, you can print the screen image to a 
printer, to the clipboard, or to a file. You can choose to print the waveform 
and grids only, the waveform and grids with the dialog, or the entire screen. 
You can also e-mail your screen images. 

 Printing 

For instructions on printing and printer setup, refer to the Printing topic. 

 Clipboard 

The Clipboard selection on the Hardcopy tab saves the screen image on 
the clipboard so you can paste a file into another application (like MS Word, 
for example). 
Saving a Screen Image to the Clipboard 

1. Touch Utilities → Utilities Setup on the menu bar. 
2. Touch the Hardcopy tab, then the Clipboard icon. 
3. Touch the Colors field and choose Standard to print the screen as it 

appears, Print to print the waveforms on a white background, or 
Black & White to print the waveforms in black & white. 

Note: Choosing Print colors saves printer toner/ink. 

4. Touch the  Hardcopy Area field to choose which part of the screen 
you want to print. Choose Grid Area Only if you do not need to print 
the dialog area and you only want to show the waveforms and grids. 
Choose DSO window if you want to print the dialogs with the 
waveforms and grids. Choose Full Screen if you want to print the 
entire screen. 

5. Touch the Print Now button . 

Note: Once you have configured your Clipboard settings on the Hardcopy 
dialog, you can touch the PRINT front panel button and touch Save Screen 
to Clipboard on the Print flyout menu. The instrument uses the Clipboard 
settings to save the screen image to the clipboard. 
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 File 

The File selection on the Hardcopy tab saves the screen image as a file to 
storage media such as a USB drive or hard drive.  
Saving a Screen Image to a File 

1. Touch Utilities → Utilities Setup on the menu bar. 
2. Touch the Hardcopy tab, then the File icon. 
3. Touch inside the File Format data entry field and select a graphic 

file format from the pop-up menu. 
4. Touch the Colors field and choose Standard to print the screen as it 

appears, Print to print the waveforms on a white background, or 
Black & White to print the waveforms in black & white. 

Note: Choosing Print colors saves printer toner/ink. 

5. Touch inside the File Name data entry field and enter a name for the 
display image, using the pop-up keyboard. 

6. Touch inside the Directory data entry field and type the path to the 
folder you want to print to, using the pop-up keyboard. Or touch the 
Browse button and navigate to the folder. 

7. Touch the  Hardcopy Area field to choose which part of the screen 
you want to print. Choose Grid Area Only if you do not need to print 
the dialog area and you only want to show the waveforms and grids. 
Choose DSO window if you want to print the dialogs with the 
waveforms and grids. Choose Full Screen if you want to print the 
entire screen. 

8. Touch the Print Now button . 

Note: Once you have configured your File settings on the Hardcopy dialog, 
you can touch the PRINT front panel button and touch Save Screen to File 
on the Print flyout menu. The instrument uses the File settings to save the 
screen image to a file (incrementing the filename by one each time you 
touch Save Screen to File). 
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 E-Mail 

The E-mail selection on the Hardcopy tab gives you the option to e-mail 
your screen images, using either the MAPI or SMTP protocols. Before you 
output to e-mail from the Utilities dialog, you first have to set up the e-mail 
server and recipient address in Preference Setup. 
E-Mailing a Screen Image 

1. Touch Utilities → Utilities Setup on the menu bar. 
2. Touch the Hardcopy tab, then the E-mail icon. 
3. Touch inside the File Format data entry field and select a graphic 

file format from the pop-up menu. 
4. Touch the Colors field and choose Standard to print the screen as it 

appears, Print to print the waveforms on a white background, or 
Black & White to print the waveforms in black & white. 

Note: Choosing Print colors saves printer toner/ink. 

5. Touch the Prompt for message to send with mail checkbox if you 
want to include remarks with the image. 

6. Touch the  Hardcopy Area field to choose which part of the screen 
you want to print. Choose Grid Area Only if you do not need to print 
the dialog area and you only want to show the waveforms and grids. 
Choose DSO window if you want to print the dialogs with the 
waveforms and grids. Choose Full Screen if you want to print the 
entire screen. 

7. Touch the Print Now button . 

Note: Once you have configured your Email settings on the Hardcopy 
dialog, you can touch the PRINT front panel button and touch Send Screen 
to Email on the Print flyout menu. The instrument uses the Email settings 
to send the screen image. 
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Auxiliary Output Signals 

From Aux Output tab on the Utilities dialog, you can output auxiliary 
signals. In addition to a calibration signal, the following signals can be 
output through the AUX OUTPUT connector: 

Note: Not all of these options are available on some oscilloscope models. 

Button:  Description: 

 

Square Wave 
 You can set a Frequency value from 5.0 Hz to 5 MHz. 

 
Trigger Out — can be used to trigger another scope. 

 
DC level — a reference level 

 
Trigger Enabled — can be used as a gating function to trigger 
another instrument when the scope is ready 

 

Pass/Fail — allows you to set a pulse duration from 1 ms to 
500 ms; generates a pulse when pass/fail testing is active and 
conditions are met.  

 
Aux Output Off — turns off the auxiliary output signal 
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Setting Up Auxiliary Output 
1. Touch Utilities → Utilities Setup on the menu bar. 
2. Touch the Aux Output tab. 
3. If you want a 1 kHz, 1 V Square Wave, touch the Set to 1 kHz, 1 V 

Square Wave button. 
 
OR 
 
If you want a specialized output, touch one of the following buttons 
under Use Auxiliary Output For: Square Wave, Trigger Enabled, 
Trigger Out, Pass/Fail, or Off. 

Note: If you choose Pass/Fail, touch inside the Pulse Duration field (if 
applicable) and enter a value from 1 ms to 500 ms, using the pop-up 
numeric keypad. 

4. If applicable, touch inside the Amplitude data entry field and enter a 
value, using the slider bar at the bottom of the window. Click the 

keypad button  on the slider bar to enter a value using the pop-
up numeric keypad. 

5. Touch inside the Frequency data entry field and enter a value, using 
the slider bar at the bottom of the window. Click the keypad button 

 on the slider bar to enter a value using the pop-up numeric 
keypad. 
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Date & Time 

From the Date & Time tab on the Utilities dialog, you can manually set the 
time and date or get it from the Internet. If you elect to get the date and time 
from the Internet, you need to have the oscilloscope connected to the 
Internet through the LAN connector on the side panel. You can also set 
time zones and daylight savings time. 
Setting the Date and Time Manually 

1. Touch Utilities → Utilities Setup on the menu bar. 
2. Touch the Date/Time tab. 
3. Touch inside each of the Hour, Minute, Second, Day, Month, and 

Year data entry fields and enter a value, using the pop-up numeric 
keypad. 

4. Touch the Validate Changes button. 
Setting the Date and Time from the Internet 

Note: The Simple Network Time Protocol (SNTP) is used. 

1. Ensure that the scope is connected to the Internet through the LAN 
connector at the side of the scope. 

2. Touch Utilities → Utilities Setup on the menu bar. 
3. Touch the Date/Time tab. 
4. Touch the Set from Internet button. 

Setting the Date and Time from Windows 
1. Touch Utilities → Utilities Setup on the menu bar. 
2. Touch the Date/Time tab. 

3. Touch the Windows Date/Time button . 
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4. Use the Time & Date Properties window to configure the time, 
including time zone. 

  
Options 

From the Options tab on the Utilities dialog, you can add or remove 
software options. For information about software options, contact your local 
LeCroy Sales and Service office, or visit our Web site at 
http://www.lecroy.com/options. 
Options that you purchase add performance to your instrument. This added 
performance is seen in the new math functions or parameters that you can 
choose from when doing Measure or Math setups. 

Preferences 

Enabling Audible Feedback 

You can choose to have audible confirmation each time you touch a screen 
or front panel control. When Audible Feedback is enabled, the oscilloscope 
beeps each time you touch the screen or front panel control. 

1. Touch Utilities → Preferences on the menu bar. 
2. Touch the Audible Feedback Enable checkbox so that the 

oscilloscope beeps with each touch of the screen or front panel 
control. 

http://www.lecroy.com/options
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Enabling Auto-calibration 

You can choose to have your instrument automatically recalibrate itself 
whenever there is a significant change in ambient temperature. If you do 
not enable this option, the oscilloscope recalibrates only at startup and 
whenever you make a change to certain operating conditions. 

1. Touch Utilities → Preferences on the menu bar. 
2. Touch the Automatic Calibration Enable checkbox. 

Optimizing Performance 

If this option is available on your oscilloscope, you can set up the 
oscilloscope to optimize either calculating speed or display speed. If the 
display update rate is of primary concern to you, optimize for Display. If 
acquisition and analysis are more important, optimize for analysis. 
Optimizing for analysis can be useful when persistence or averaging is 
used, giving higher priority to waveform acquisition at the expense of 
display update rate. 
The choices are presented as a spectrum with highest values at the 
extremes: 

 
1. Touch Utilities → Preferences on the menu bar. 
2. Touch one of the optimization icons. 

Setting an Offset Control 

As you change the gain, this control allows you to either keep the vertical 
offset level indicator stationary (when Div is selected) or to have it move 
with the actual voltage level (when Volts is selected). The advantage of 
selecting Div is that the waveform will remain on the grid as you increase 
the gain; whereas, if Volts is selected, the waveform may move off the grid. 

Note: Regardless of whether you select Volts or Div, the Offset shown in 
the channel setup dialog always indicates volts. However, when Div is 
selected for the Offset Control, the offset in volts is scaled proportional to 
the change in gain, thereby keeping the division on the grid constant. 

1. Touch Utilities → Preferences on the menu bar. 
2. Touch the Acquisition tab. 
3. Under Offset Setting constant in:, touch either the Div or Volts 

button. 
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Setting a Delay Control 

As you change the timebase, this control allows you to either keep the 
horizontal offset indicator stationary (when Div is selected) or to have it 
move with the trigger point (when Time is selected). The advantage of 
selecting Div is that the trigger point will remain on the grid as you increase 
the timebase; whereas, if Time is selected, the trigger point could move off 
the grid. 

Note: Regardless of whether you select Time or Div, the Delay shown in 
the timebase setup dialog always indicates time. However, when Div is 
selected for Delay In, the delay in time is scaled proportional to the 
change in timebase, thereby keeping the division on the grid constant. 

1. Touch Utilities → Preferences on the menu bar. 
2. Touch the Acquisition tab. 
3. Under Delay Setting constant in:, touch either the Div or Volts 

button. 
Configuring E-mail Settings 

Before you can send e-mail from the oscilloscope, it must first be 
configured. 

1. Touch Utilities → Preferences on the menu bar. 
2. Touch the E-mail tab. 
3. Choose an e-mail server protocol: 

 
 MAPI (Messaging Application Programming Interface) is the 
Microsoft interface specification that allows different messaging and 
workgroup applications (including e-mail, voice mail, and fax) to work 
through a single client, such as the Exchange client. MAPI uses the 
default Windows e-mail application (usually Outlook Express). 
 
 SMTP (Simple Mail Transfer Protocol) is a TCP/IP protocol for 
sending messages from one computer to another through a network. 
This protocol is used on the Internet to route e-mail. In many cases 
no account is needed. 
 

4. If you chose MAPI, touch inside the Originator Address (From:) 
data entry field and use the pop-up keyboard to type in the 
instrument's e-mail address. Then touch inside the Default 
Recipient Address (To:) data entry field and use the pop-up 
keyboard to enter the recipient's e-mail address. 
OR 
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If you chose SMTP, touch inside the SMTP Server data entry field 
and use the pop-up keyboard to enter the name of your server. 
Touch inside the Originator Address (From:) data entry field and 
use the pop-up keyboard to type in the instrument's e-mail address. 
Then touch inside the Default Recipient Address (To:) data entry 
field and use the pop-up keyboard to enter the recipient's e-mail 
address. 

5. To send a test e-mail text message, touch the Send Test Mail 
button. The test message reads "Test mail from [name of scope's 
email address]." 

Acquisition Status 

For each general category of oscilloscope operation, you can view a 
summary of your setups. To access these status dialogs, choose the 
following: 

 Vertical → Channels Status on the menu bar 
 Timebase →Acquisition Status on the menu bar 
 Trigger → Acquisition Status on the menu bar 
 Math → Math Status, Zoom Status, or Memory Status on the 

menu bar 
In addition to these dialogs, summaries are also provided for XY setups, 
memory (M1-M4) setups, and time stamps for sequence mode sampling.  

Service 

 This button on the Utilities Setup dialog provides access to service 
dialogs, which are for the sole use of LeCroy service personnel. A security 
code is required to gain access. 

Show Windows Desktop 

Touch the Show Windows Desktop button  on the Utilities Setup 
dialog to minimize the instrument application. To maximize the application, 
touch the appropriate shortcut icon 

    . 
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Touch Screen Calibration 

To start the calibration procedure, touch the Touch-Screen Calibration 
button.  

  
During the calibration, you will be prompted to touch the center of a small 
cross in five key locations on the touch screen.  
  

PLEASE NOTE THE FOLLOWING: 
 Because sufficient accuracy cannot be achieved using your finger, 

use a stylus instead for this procedure. 
 The calibration has a ten-second timeout in case no cross is 

touched. 
 To avoid parallax errors, be sure to place your line of sight directly in 

front of each cross before touching it. 

 
Restoring Software 

System Recovery for Oscilloscopes Running Windows XP and 
Vista 

Your oscilloscope is designed to operate reliably for many years. However, 
the application software operating the instrument runs on a Windows 
platform. The loading or incomplete removal of additional Windows 
applications may eventually cause problems in the stability of the operating 
system. Severe cases may require a reloading of the base operating 
system and oscilloscope application. This is done using a recovery routine 
that restores a clean copy of the image originally installed on the C: drive. 

Note: Any user and calibration data located on the D: partition is not 
affected by the recovery process. 

LeCroy provides you with a recovery application and a backup image in an 
extra partition on the instrument‘s hard drive. The recovery process is easy 
to perform, using the following instructions . After the recovery procedure is 
done, you must activate Windows, either by Internet connection to 
Microsoft‘s Web site or by telephone. Have your Windows Product Key 
number (located on the rear of the oscilloscope) handy during Widows 
reactivation.  
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Note: The recovery process produces a replica of the operating system 
and oscilloscope application software at the current revision levels when 
the oscilloscope was manufactured. Any further revisions of the 
application software, Windows operating system, and virus scan definition 
files are not automatically upgraded. Therefore, after completion of the 
disk image recovery, it is highly recommended to search vendor Web 
sites and upgrade the individual components to current revision levels. 
The current oscilloscope application software can be downloaded directly 
from the LeCroy website at www.lecroy.com. Since the calibration data for 
the oscilloscope is stored in the D: drive, current calibration constants are 
not overwritten during the recovery process. 

Recovery Procedure 
1. Connect a network cable to the LAN port on the rear of the 

oscilloscope if you intend to activate windows through the Internet. 
2. Connect a keyboard and a mouse to the oscilloscope. 
3. Apply power to the oscilloscope. 
4. As soon as the LeCroy logo appears on the screen, press and hold 

down the F4 key until the recovery software logo appears 
momentarily: 

 
5. Then the cME console End User License Agreement is displayed. 

Read the agreement, and click Accept: 

http://www.lecroy.com/
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6. The Phoenix cME Console main page is displayed. Click Click here 

to start recover: 
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7. The FirstWare Recover splash screen is displayed momentarily: 

 
8. The recovery starts, and the FirstWare Progress screen is displayed. 

No further selections are required. The recovery takes about 10 
minutes. 

 
Note: The screen goes blank on occasion for prolonged periods. 
This is normal and is not an indication of any malfunctioning of the 
recovery process. 

9. After the recovery is completed, the X-Stream software installer 
screen appears. Click Next to continue: 
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10. When the X-Stream installation is completed, reboot the oscilloscope 

(as follows). 
Now you must activate Windows by Internet connection to Microsoft‘s Web 
site or by telephone. When activating, have the Windows Product Key 
number handy (it is affixed to the rear of the oscilloscope). 
Restarting the Application 

Upon initial power-up, the oscilloscope automatically loads the instrument 
application software. If you exit the application and want to reload it, touch 
the shortcut icon on the desktop: 

  
If you minimize the application, touch the appropriate task bar or desktop 
icon to maximize it:   

 . 
Restarting the Operating System 

If you need to restart the Windows® operating system, reboot the 
oscilloscope by pressing and holding in the power switch for 10 seconds, 
then turning the power on again. 
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Reference 
WavePro Specifications 

Note: Specifications are subject to change without notice. 

Vertical System WavePro 715Zi 
SDA, 

WavePro 
725Zi 

SDA, DDA, 
WavePro 

735Zi 

SDA, 
WavePro 

740Zi 

SDA, DDA, 
WavePro 

760Zi 

Analog (ProLink Input) 
Bandwidth @ 50Ω (-3dB) 
(≥ 10 mV/div) 

NA NA NA 
4 GHz 
(≥ 
10mV/div) 

6 GHz 
(≥ 10mV/div) 

Analog (ProBus Input) 
Bandwidth @ 50Ω (-3dB) 

1.5 GHz 
(≥ 10mV/div) 

2.5 GHz 
(≥ 
10mV/div) 

3.5 GHz 
(≥ 
10mV/div) 

3.5 GHz 
(≥ 
10mV/div) 

3.5 GHz 
(≥ 10mV/div) 

Analog (ProBus Input) 
Bandwidth @ 1 MΩ (-
3dB) 

500 MHz 
(typical) 

500 MHz 
(typical) 

500 MHz 
(typical) 

500 MHz 
(typical) 

500 MHz 
(typical) 

Rise Time (Typical) 235 ps 150 ps 120 ps 105 ps 70 ps 
Input Channels 4 

Bandwidth Limiters 20 MHz, 200 MHz, 1 GHz 20 MHz, 200 MHz, 1 
GHz, 3 GHz 

20 MHz, 200 
MHz, 1 GHz, 
3 GHz, 4 
GHz 

Input Impedance 50 Ω ±2% or 1 MΩ || 16 pF, 10 MΩ || 11 pF with supplied probe 
Input Cooling 1 MΩ: AC, DC, GND; 50 Ω: DC, GND 

Maximum Input Voltage 

50 Ω: ±5 Vrms 
 
1 MΩ: 250 V max, (peak AC: ≤ 10 kHz + 
DC) 

50 Ω (ProBus): ±5 Vrms 
50 Ω (ProLink): ±4 Vpeak 
1 MΩ (ProBus): 250 V 
max 
(peak AC: ≤ 10 kHz + 
DC) 

Vertical Resolution 8 bits; up to 11 bits with enhanced resolution (ERES) 

Sensitivity 50 Ω: 2 mV-1 V/div, fully variable (2-9.99 mV/div via zoom); 1 MΩ: 2 
mV-10 V/div, fully variable 

DC Gain Accuracy ±1.5% of full scale 

Offset Range 

50 Ω (ProBus Input): 
±750 mV @ 10–170 mV/div 
±4 V @ 172 mV/div–1 V/div 
1 MΩ: (ProBus Input): 
±1 V @ 2–128 mV/div 
±10 V @ 130 mV–1.28 V/div 
±100 V @ 1.3 V–10 V/div 

50 Ω (ProLink Input): 
±750 mV @ 10–118 
mV/div 
±4 V @ 120 mV/div–1 
V/div 
50 Ω (ProBus Input): 
±750 mV @ 10–170 
mV/div 
±4 V @ 172 mV/div–1 
V/div 
1 MΩ: (ProBus Input): 
±1 V @ 2–128 mV/div 
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Vertical System WavePro 715Zi 
SDA, 

WavePro 
725Zi 

SDA, DDA, 
WavePro 

735Zi 

SDA, 
WavePro 

740Zi 

SDA, DDA, 
WavePro 

760Zi 

±10 V @ 130 mV–1.28 
V/div 
±100 V @ 1.3 V–10 V/div 

Offset Accuracy ±(1.5% of full scale +1.0% of offset value +1 mV) 

  

Horizontal System 
WavePro 

715Zi 

SDA, 
WavePro 

725Zi 

SDA, DDA, 
WavePro 

735Zi 

SDA, 
WavePro 

740Zi 

SDA, DDA, 
WavePro 

760Zi 

Timebases Internal timebase common to 4 input channels; an external clock 
may be applied at the auxiliary input 

Time/Division Range Real time: 20 ps/div-1000 s/div (RIS mode: 20 ps/div-10 ns/div; Roll 
mode: up to 1000 s/div) 

Clock Accuracy ≤ 1 ppm+ (aging of 0.5 ppm/yr from last calibration) 
Time Interval Accuracy < 0.06 / SR + (clock accuracy* Reading) (rms) 

Jitter Noise Floor 1.5 ps 
(Typical) 

1 ps 
(Typical) 

800 fs 
(Typical) 

750 fs 
(Typical) 

560 fs 
(Typical) 

Trigger and Interpolator 
Jitter 

3 psrms 
(Typical) 

 
2 psrms (Typical) 1 psrms (Typical) 

Channel-Channel 
Deskew Range ±9 x time/div. setting, 100 ms max., each channel 

External Timebaase 
Reference (Input) 10 MHz; 50 Ω impedance, applied at the rear input 

Extrenal Timebase 
Reference (Output) 10 MHz; 50 Ω impedance, applied at the rear output 

External Clock 0.1 Hz-100 MHz, 50 Ω or 1 MΩ impedance, applied at the auxiliary 
input 

  
Acquisition System WP715Zi WP725Zi WP735Zi WP740Zi WP760Zi 

Single-Shot Sample 
Rate/Ch 

20 GS/s on 2 Ch 
10 GS/s on 4 Ch 

(Option WPZi-1.5GHz-
4X20GS doubles the sample 

rate) 

40 GS/s on 2 Ch 
20 GS/s on 4 Ch 

Random Interleaved 
Sampling (RIS) 200 GS/s for repetitive signals (20 ps/div, to 10 ns/div) 

Maximum Trigger Rate 1,00,000 waveforms/second (in Sequence Mode, up to 4 channels) 
Intersegment Time 800 µs 
Maximum Acquisition 
Memory Points/Ch (4 Ch / 2 Ch) Number of Segments 

Standard Memory 

10 M / 20 M (Standard 
memory for SDA and DDA 
Oscilloscopes are 20 M / 40 
M) 

5000 

S-32 - Memory Option 32 M / 64 M 15,000 
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Acquisition System WP715Zi WP725Zi WP735Zi WP740Zi WP760Zi 

M-64 - Memory Option 64 M / 128 M 15,000 
L-128 - Memory Option 128 M / 256 M 15,000 

  
Acquisition Processing   

Averaging Summed averaging to 1 million sweeps; continuous 
averaging to 1 million sweeps 

Enhanced Resolution (ERES) From 8.5 to 11 bits vertical resolution 
Envelope (Extrema) Envelope, floor, or roof for up to 1 million sweeps 
Interpolation Linear or Sin x/x 

  

Triggering 
System 

WavePro 
715Zi 

SDA, 
WavePro 

725Zi 

SDA, 
DDA, 

WavePro 
735Zi 

SDA, 
WavePro 

740Zi 

SDA, DDA, 
WavePro 

760Zi 

Modes Normal, Auto, Single, and Stop 
Sources 
Coupling Mode 

Any input channel, Aux, Aux/10, or line; slope and level unique to each 
source (except line trigger) 

Coupling Mode DC, AC, HFRej, LFRej 
Pre-Trigger Delay 0-100% of memory size (adjustable in 1% increments of 100 ns) 

Post-Trigger Delay 0-10,000 divisions in real time mode, limited at slower time/div settings or 
in roll mode 

Hold-off by Time or 
Events From 2 ns up to 20 s or from 1 to 99, 999,999 events 

Internal Trigger 
Range ±4.1 div from center 

Trigger Sensitivity 
with Edge Trigger 
(Ch 1-4) ProBus 
Inputs 

2 div @ < 1 
GHz 

1.5 div @ < 
500 MHz 

1.0 div @ < 
200 MHz 

(for DC, AC, 
LFRej 

coupling, ≥ 10 
mV/div, 50 Ω) 

2 div @ < 2.5 
GHz 

1.5 div @ < 
1.25 GHz 

1.0 div @ < 
200 MHz 

(for DC, AC, 
LFRej 

coupling, ≥ 10 
mV/div, 50 Ω) 

2 div @ < 3.5 GHz 
1.5 div @ < 1.75 GHz 
1.0 div @ < 200 MHz 

(for DC, AC, LFRej coupling, ≥ 10 mV/div, 
50 Ω) 

Trigger Sensitivity 
with Edge Trigger 
(Ch 1-4) ProLink 
Inputs 

Not Applicable 

2 div @ < 4 
GHz 

1.5 div @ 2 
GHz 

1.0 div @ 200 
MHz 

(for DC, AC, 
LFRej 

coupling, ≥ 10 
mV/div, 50 Ω) 

2 div @ < 6 
GHz 

1.5 div @ 3 
GHz 

1.0 div @ 200 
MHz 

(for DC, AC, 
LFRej 

coupling, ≥ 10 
mV/div, 50 Ω) 

External Trigger 
Sensitivity, (Edge 
Trigger) 

2 div @ < 1 GHz 
1.5 div @ < 500 MHz 
1.0 div @ < 200 MHz 
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Triggering 
System 

WavePro 
715Zi 

SDA, 
WavePro 

725Zi 

SDA, 
DDA, 

WavePro 
735Zi 

SDA, 
WavePro 

740Zi 

SDA, DDA, 
WavePro 

760Zi 

(for DC, AC, LFRej coupling) 

Max, Trigger 
Frequency, 
SMART Trigger™ 

1.0 GHz @ ≥ 
10 mV/div 
(minimum 
triggerable 

width 500 ps) 

2.0 GHz @ ≥ 
10 mV/div 
(minimum 
triggerable 

width 500 ps) 

2.0 GHz @ 
≥ 10 

mV/div 
(minimum 
triggerable 
width 500 

ps) 

2.0 GHz @ ≥ 10 mV/div 
(minimum triggerable width 

500 ps) 

External Trigger 
Input Range Aux (±0.4 V); Aux/10 (±4 V) 

  

Basic Triggers 

Edge Triggers when signal meets slope (positive, negative, or either) 
and level condition. 

TV-Composite Video 

Triggers NTSC or PAL with selectable line and field; HDTV 
(720p, 1080i, 1080p) with selectable frame rate (50 or 60 Hz) 
and Line; or CUSTOM with selectable Fields (1-8), Lines (up to 
2000), Frame Rates (25, 30, 50, or 60 Hz), Interlacing (1:1, 2:1, 
4:1, 8:1), or Synch Pulse Slope (Positive or Negative). 

Window Trigger when signal or exits a window defined by adjustable 
thresholds. 

  
SMART Triggers 

State or Edge Qualified 
Triggers on any input source only if a defined state or edge 
occurred on another input source. 
Delay between source is selectable by time or events. 

Qualified First 

In Sequence acquisition mode, triggers repeatably on event B 
only if a defined pattern, state, or edge (event A) is satisfied in 
the first segment of the acquisition. Delay between sources is 
selectable by time or events. 

Dropout Triggers if signal drops out for longer than selected time 
between 1 ns and 20 s. 

Pattern 

Logic combination (AND, NAND, OR, NOR) of 5 inputs (4 
channels and external trigger input). 
Each source can be high, low, or don't care. The High and Low 
level can be selected independently. 
Triggers at start or end of the pattern. 

  
SMART Triggers with Exclusion Technology 

Glitch 
Triggers on positive or negative glitches with widths selectable 
as low as 200 ps (depending on oscilloscope bandwidth) to 20 
s, or on intermittent faults. 

Width (Signal or Pattern) Triggers on positive, negative, or both widths with widths 
selectable as low as 200 ps (depending on oscilloscope 
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SMART Triggers with Exclusion Technology 

bandwidth) to 20 s, or on intermittent faults. 
Interval (Signal or Pattern)  Triggers on intervals selectable between 1 ns and 20 s. 

Timeout (State/Edge 
Qualified) 

Triggers on any source if a given state (or transition edge) has 
occurred on another source. 
Delay between sources is 1 ns, to 20 s, or 1 to 99,999,999 
events. 

Runt 
Trigger on positive or negative runts defined by two voltage 
limits and two time limits. 
Select between 1 ns and 20 ns. 

Slew Rate Trigger on edge rates. Select limits for dV, dt, and slope. Select 
edge limits between 1 ns and 20 ns. 

Exclusion Triggering Trigger on intermittent faults by specifying the expected 
behavior and triggering when that condition is not met. 

  
High-Speed Serial 

Protocol Triggering 
WavePro715Zi 

WavePro 
725Zi 

WavePro 
735Zi 

WavePro 
740Zi 

WavePro 
760Zi 

Data Rates Not available 
(Option WPZi-MSPT 
Standard with SDA) 
50 Mb/s-1.25 Gb/s 

(Option WPZi-HSPT 
Standard with SDA) 
50 Mb/s-2.7 Gb/s 

Pattern Length - 80 bits, NRZ or 8b10b 

Clock and Data Outputs - 400 mVp-p (typical), AC coupled 
 

Clock Recovery Jitter - 1 psrms + 0.3% Unit Interval rms for PRBS data 
patterns with 50% transition density 

Hardware Clock Recovery 
Loop BW - PLL Loop BW = Fbaud/5500, 50 Mb/s to 1.25 

Gb/s (Typical) 

  
Low-Speed Serial Protocol Triggering (Optional) 

Available I2C, SPI, (SPI, SSPI, SIOP), UART-RS232, CAN, LIN, FlexRay 
Reference individual datasheets for complete specifications. 

  
Color Waveform Display 

Type Color 15.3" flat panel TFT-Active Matrix LCD with high 
resolution touch screen 

Resolution WXGA; 1280 X 768 pixels 

Number of Traces Display a maximum of 8 traces. Simultaneously display channel 
zoom, memory, and math traces. 

Grid Styles Auto, Single, Dual, Quad, Octal, X-Y, Single+X-Y, Dual +X-Y 
Waveform Representation Sample dots joined, or sample dots only 

  
Integrated Second Display (optional) 

Type Color 15.3" flat panel TFT-Active Matrix LCD with high 
resolution touch screen 

Resolution WXGA; 1280 x 768 pixels 
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LeCroy WaveStream Fast Viewing Mode 

Intensity 256 Intensity Levels, 1-100% adjustable via front panel control 
Number of Channels Up to 4 simultaneously 
Type Select analog or color graded 

Max. Sampling Rate 40 GS/s (20 GS/s for WavePro 715Zi without WPZi-1GHZ-
4X20GS option) 

Persistence Aging Select from 500 ms to Infinite 
Waveforms/Second 
(continuous) Up to 2500 Waveforms/second 

  
Analog Persistence Display 

Analog and Color-Graded 
Persistence 

Variable saturation levels; stores each trace's persistence data 
in memory 

Persistence Types Select analog, color, or three-dimensional 
Trace Selection Active persistence on all or any combination of traces 
Persistence Aging Select from 500 ms to infinity 
Sweep Display Modes All accumulated, or all accumulated with last trace highlighted 

  
High-Speed Digitizer Output (Option) 

Type LeCroy LSIB 
Transfer Rate Up to 250 Mpts/s (Maximum) 
Output Protocol PCI Express, Gen1 (4 lanes utilized for data transfer) 
Control Protocol TCP/IP 
Command Set Via Windows Automation or LeCroy Remote Command Set 

  
Zoom Expansion Traces 

  Display up to 4 Zoom and 8 Math/Zoom traces 

  
Processor/CPU 

Type Intel® Core™ 2 Quad, 2.5 GHz (or better) 

Processor Memory 
2 GB standard, up to 8 GB optional 

(4 GB standard with S-32 memory, 8 GB standard with M-64 or 
L-128 memory) 

Operating System Microsoft Windows® Vista® Business Edition (64-bit) with SP1 

Real Time Clock Date and time displayed with waveform and in hardcopy files. 
SNTP support to synchronize to precision internal clocks. 

  

Internal Waveform Memory 

  

4 active waveform memory traces (M1-M4) store 16-bit/point full 
length waveforms. 

Waveforms can be stored to any number of files limited only by 
the data storage media capacity. 
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Setup Storage 

Front Panel and Instrument 
Status 

Store to the internal hard drive or to a USB-connected 
peripheral device. 

  

Interface 
WavePro 

Z10Zi 
WavePro 

Z25Zi 
WavePro 

Z35Zi 
WavePro 

Z40Zi 
WavePro 

Z60Zi 

Remote Control Via Windows Automation, or LeCroy Remote Command Set 
Network 
Communication 
Standard 

LXI Class C, VXI-11, VICP, DCOM 

GPIB Port 
(optional) Supports IEEE - 488.2 

LSIB Port 
(optional) Supports PCI Express Gen1 x4 protocol with LeCroy supplied API 

USB Device 
Port (optional) Type-B 

Ethernet Port Supports 10/100/1000BaseT Ethernet interface (RJ45 port) 

USB Ports Minimum 6 total (including 3 front panel) USB 2.0 ports support Windows 
compatible devices 

External 
Monitor Port 

15-pin D-Type WXGA compatible to support customer-supplied external 
monitor. DVI and power connector to support LeCroy WPZi-EXTDISP-15 
additional touch screen display accessory. Includes support for extended 

desktop operation with optional LeCroy or other second monitor. 
Peripheral Bus LeCroy LBUS standard  

  

Auxiliary Input 

Signal Types Select External Trigger or External Clock Input on the front 
panel 

Coupling 50 Ω: DC; 1 MΩ: AC, DC, GND 

Max. Input Voltage 50 Ω: 5 Vrms; 1 MΩ: 250 V (Peak AC < 10 kHz + DC) 
 

  

Auxiliary Output 

Signal Types Select from calibrator, control signals, or Off 

Calibrator Signal 500 Hz-5 MHz square wave or DC level; 0.0 to 500 mV into 50 
Ω (0-1 V into 1 MΩ) 

Control Signals Trigger enabled, trigger out, pass/fail status 

  

Automatic Setup 

Auto Setup Automatically sets timebase, trigger, and sensitivity to display a 
wide range of repetitive signals 

Find Vertical Scale 
Automatically sets the vertical sensitivity and offset for the 
selected channel to display a waveform with the maximum 

dynamic range 
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General 

Auto Calibration Ensures specified DC and timing accuracy is maintained for 1 
year minimum. 

  

Probes 

Probes Qty. (4) ÷ 10 Passive Probes 

Probe System ProBus (and ProLink on 4 and 6 GHz models). Automatically 
detects and supports a variety of compatible probes 

Scale Factors Automatically or manually selected depending on probe used 

Calibration Output 1 kHz square wave, 1 Vp-p (typical), output to probe hook 
 

  

Power Requirements 

Voltage 100-240 VAC ±10% at 50/60 Hz; 100-120 VAC ±10% at 400 
Hz; Automatic AC Voltage Selection 

Max. Power Consumption 800 W/800 VA 

  

Environmental 

Temperature (Operating) +5 °C to +40 °C including CD-RW/DVD-ROM drive 
Temperature (Non-Operating) -20 °C to + 60 °C 

Humidity (Operating) 
5% to 80% relative humidity (non-condensing) up to +31 °C. 

Upper limit derates to 50% relative humidity (non-condensing) 
at +40 °C. 

Humidity (Non-Operating) 5% to 95% relative humidity (non-condensing) as tested per 
MIL-PRF-28800F 

Altitude (Operating) Up to 10,000 ft. (3048 m) at or below +25 °C 
Altitude (Non-Operating) Up to 40,000 ft. (12,192 m) 

Random Vibration (Operating) 0.5 grms 5 Hz to 500 Hz, 15 minutes in each of three orthogonal 
axes 

Random Vibration (Non-
Operating) 

2.4 grms 5 Hz to 500 Hz, 15 minutes in each of three orthogonal 
axes as tested per MIL-PRF-28800F 

Functional Shock 
20 g peak, half sine, 11 ms pulse, 3 shocks (positive and 

negative) in each of three orthogonal axes, 18 shocks total as 
tested per MIL-PRF-28800F 

 Physical Dimensions 

Dimensions (HWD) 355 mm x 467 mm x 289 mm; 14' x 18.4" x 11.4" (height 
excludes feet) 

Weight 18.4 kg; 40 lbs. 
Shipping Weight 26.6 kg; 58 lbs. 
 Certifications 

  
CE Compliant, UL and cUL listed; conforms to EN 61326, EN 

61010-1, UL 61010-1 2nd edition, and CSA C22.2 No. 61010-1-
04 

 Warranty and Service 

  
Three-year warranty; calibration recommended annually. 

Optional service programs include extended warranty, 
upgrades, and calibration services. 
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Technical Support 

For assistance with installation, calibration, and a full range of software 
applications contact the customer service center nearest you. You can also 
find contact information for the following offices on the LeCroy Web site at 
http://www.lecroy.com/tm/ServiceSupport. 

Contact Your Local LeCroy Technical Support Office for Help 

United States and Canada 
Phone Sales: 800-553-2769 or 845-

425-2000 
Fax (Sales&Service): 845-578-5985 

Email Sales: contact.corp@lecroy.com 
Web Site: http://www.lecroy.com/ 

Europe 
Phone Sales: + 41 22 719 2228 

Fax Sales: + 41 22 719 2230 
Email Sales: 

contact.sa@lecroy.com 
Web Site: 

http://www.lecroy.com/europe  

China 
Phone Sales: ++86 28- 86527180 / 

7181 / 7182 
Fax Sales: +86 28-8652 7183 

Email Sales: george.ni@lecroy.com  

Singapore 
Phone Sales: ++ (65) 64424880 

Fax Sales: ++ (65) 64427811 
Email Sales: 

jimmy.ong@lecroy.com 

TaiwanPhone Sales: (886) 2 8226 
1366 

Fax Sales: (886) 2 8226 1368 
Email Sales: sales_twn@lecoln.com.tw 

Web Site: http://www.lecoln.com.tw 

Tokyo 
Phone Sales: ++ 81 3 3376 9400 

Fax Sales: ++ 81 3 3376 9587 
Web Site: 

http://www.lecroy.com/japan 

Korea - Seoul 
Phone Sales: ++ 82 2 3452 0400 

Fax Sales: ++ 82 2 3452 0490 
Web Site: http://www.lecroy.co.kr 

 

http://www.lecroy.com/tm/ServiceSupport/default.asp?menuid=69


Thank you for purchasing a
WavePro, SDA, or DDA 7 Zi 
Oscilloscope

Corporate Headquarters
700 Chestnut Ridge Road
Chestnut Ridge, NY 10977
USA
www.lecroy.com




